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1. Introduction 
Il s'agit d'un guide étape par étape de l'observation des exoplanètes qui est destinée à la fois au nouveau venu 

dans ce domaine qu’à l’observateur d'exoplanètes plus expérimenté. Pour le premier, il est souhaitable que 

l'utilisateur détienne une certaine expérience dans le domaine du ciel profond ou de l'imagerie des étoiles 

variables. L'observateur d'exoplanètes plus expérimenté peut voir l’utilité de ce guide comme un rappel sur les 

« meilleures pratiques », tout comme un guide pratique pour l'utilisation d'AstroImageJ (AIJ) pour le 

traitement d'images et la modélisation de transits d'exoplanètes. AIJ est un logiciel gratuiciel qui est aussi un 

ensemble de fonctions tout-en-un pour l'étalonnage d'images, la photométrie différentielle et la modélisation 

d'exoplanètes. AIJ est en voie de devenir le standard de facto pour l'analyse et la modélisation des exoplanètes 

par des astronomes amateurs avancés ainsi que par certains astronomes professionnels. 

Ce manuel guidera l'utilisateur à travers toutes les phases d'observation des exoplanètes, de la sélection des 

cibles appropriées à la modélisation des transits d’exoplanètes. De réels transits sont utilisés pour démontrer 

les techniques et les capacités d'AIJ pour la modélisation du transit d'exoplanètes. 

Vous trouverez les liens vers la dernière version de ce guide et les documents qui l'accompagnent à 

http://astrodennis.com. 

Dans les différentes sections ci-dessous, l’on fait référence à un autre Guide de l'utilisateur des AIJ, rédigé par 

le développeur d'AIJ et qui décrit davantage de détails et d'options sur l'utilisation des AIJ que ce guide. La 

dernière version du Guide de l'utilisateur des AIJ et un lien vers le forum des utilisateurs d'AIJ peuvent être 

consultés sur le site Web de l'AIJ: http://www.astro.louisville.edu/software/astroimagej/. On trouvera une 

description détaillée des caractéristiques des AIJ dans le document suivant: http://arxiv.org/abs/1601.02622. 

 

2. Contexte 
En 1995, 51 Pegasi b était la première exoplanète détectée autour d'une étoile de séquence principale. À ce 

jour, plus de 3 500 exoplanètes ont été confirmées par Kepler et d'autres observatoires spatiaux et terrestres. 

Les astronomes amateurs ont réussi à détecter les exoplanètes depuis au moins une décennie, et ce, avec une 

incroyable précision! De plus, ils ont pu faire de telles observations avec le même équipement qu'ils utilisent 

pour créer des images spectaculaires du ciel profond ou des courbes de lumière d'étoiles variables. 

Plusieurs exemples d'astronomes amateurs fournissent des données précieuses à l'appui de la recherche sur 

les exoplanètes. En 2004, une équipe d'astronomes professionnels et amateurs a collaboré au projet XO, qui a 

abouti à la découverte de plusieurs exoplanètes. Le programme KELT (Kilodegree Extremely Little Telescope) 

(Pepper et al., 2007) utilise réseau mondial d’astronome amateurs et de petits collèges, en collaboration avec 

les astronomes professionnels, pour effectuer des observations de suivi des exoplanètes candidates transitant 

devant des étoiles brillantes. Un réseau d'astronomes amateurs a récemment soutenu une étude de Hubble 

sur une quinzaine d'exoplanètes en effectuant des observations sur la longueur d'onde optique, alors que 

Hubble étudiait ces mêmes exoplanètes dans le proche infrarouge (Conti, 2015 et Motta, 2017). De telles 

observations d'astronomes amateurs aident à confirmer les exoplanètes candidates, ainsi qu'à affiner les 

éphémérides d'exoplanètes déjà connues. Le simple fait que les astronomes amateurs puissent modéliser avec 

précision les transits des exoplanètes existantes signifie qu'il leur est théoriquement possible de découvrir de 

nouvelles exoplanètes! Par exemple, en détectant les variations du temps d’un transit d'une exoplanète 

http://arxiv.org/abs/1601.02622
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connue (une technique appelée « transit time variations » ou TTV), les astronomes amateurs peuvent détecter 

l'existence d'une autre planète en orbite autour de l'étoile hôte. 

La formalisation des techniques des « meilleures pratiques » pour la détection des exoplanètes par les 

astronomes amateurs a commencé en 2007 avec la publication de «Exoplanet Observing for Amateurs», par 

Bruce Gary. En même temps, Gary a commencé à archiver les observations d'exoplanètes de d'autres 

astronomes amateurs. Ces Archives sur les Exoplanètes amateurs (AXA), ont ensuite été transférées vers le 

projet de base de données « Exoplanet Transit Database (ETD) », plus actif, c’est une archive en ligne 

commanditée par la « Czech Astronomical Society » qui est la Société d’astronomie de la république Tchèque. 

(http://var2.astro.cz/ETD/contribution .php). 

Puisque de nouveaux télescopes spatiaux tels que le TESS (Transiter Exoplanet Survey Satellite) (Ricker et al., 

2015) et le JWST (James Webb Space Telescope) (NASA, 2017) seront mis en ligne dans les 2 ou 3 prochaines 

années, la recherche d'exoplanète ne fera qu’augmenter. En particulier, des observations de suivi 

d'exoplanètes candidates seront nécessaires pour aider à déterminer si un transit observé est un faux positif - 

par exemple, si le transit est réellement dû à une exoplanète ou à un binaire éclipsant. 

Afin de contribuer à la science des exoplanètes, les observations d'astronomes amateurs exigent une approche 

beaucoup plus rigoureuse que celle requise pour les efforts d'astronomes amateurs plus typiques, comme 

l’imagerie du ciel profond ou planétaire. Ce guide décrit les meilleures pratiques qui ont évolué à ce jour pour 

effectuer de telles observations d'exoplanètes de qualité scientifique. 

La section 3 donne un aperçu de l'observation des exoplanètes. La section 4 discute de certaines des 

considérations impliquées dans la sélection de l'équipement pour l'observation des exoplanètes. La section 5 

examine les étapes préliminaires à suivre avant l'observation elle-même. La section 6 passe en revue les 

meilleures pratiques impliquées dans une observation d'exoplanètes. Enfin, la section 7 présente une 

description détaillée de l'utilisation d’AIJ dans pour l’analyse des images et la modulation de transit des 

exoplanètes. 

 

3. Observation des exoplanètes 
Le concept de base de l'observation des exoplanètes consiste à prendre une série d'images du champ 

entourant l'étoile hôte d'une exoplanète avant, pendant et après les instants prévus du transit de l'exoplanète 

devant son étoile hôte. 

Comme la méthode de transit est la technique dominante utilisée par les astronomes amateurs pour effectuer 

des observations d'exoplanètes, ce guide se concentre sur l'observation et la modélisation des techniques liées 

à cette méthode. La méthode de transit est utile pour détecter un "Jupiter chaud", à savoir une grosse planète 

dont l'orbite est proche de son étoile hôte et où la planète passe directement devant l'étoile du point de vue 

d'un observateur sur Terre. La méthode de transit repose sur la mesure du flux de l'étoile hôte suspecte 

(appelée aussi « l’étoile cible »), ainsi que sur le flux de multiples « étoiles de comparaison » qui sont toutes 

dans le même champ de vision. 

Les transits d’exoplanètes durent généralement de 2 à 4 heures. Cependant, la réalisation d'une observation 

d'exoplanète implique également le début de la séance d'imagerie au moins 30 minutes avant le début prévu 

du transit « pré-entrée » et se poursuit pendant au moins 30 minutes après le transit prévu « post-sortie ». Ces 

temps de « pré-entrée » et de « post-sortie » sont utilisés pour aider à établir une ligne de référence en dehors 
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du transit (OOT), donc avant et après le transit. Ainsi, il n'est pas rare qu'une session d'observation d'une 

exoplanète soit de 6 heures. 

Une technique appelée photométrie différentielle est utilisée pour déterminer les changements de luminosité 

(flux) de l'étoile hôte de l'exoplanète qui pourraient indiquer un transit d'une exoplanète. Cette technique 

compare la différence relative entre l'étoile hôte et une ou plusieurs étoiles de comparaison (présumées non 

variables) ou de « comparaison » pendant la séance d'imagerie. Étant donné que la différence de luminosité 

de l'étoile hôte et de la ou des étoile (s) de comparaison est également influencée par des facteurs communs 

tels que les minces nuages aériens, la lueur lunaire, la pollution lumineuse, etc., une variation de cette 

différence serait une mesure des effets de la baisse de la luminosité de l'étoile hôte en raison d'une 

exoplanète transitant devant elle. 

Les points de données qui représentent la variation relative de la luminosité de l'étoile sont ensuite utilisés 

pour modéliser le transit de l'exoplanète. Un modèle de transit « best fit » est alors créé à partir de ces points 

de données. Ce meilleur ajustement donne lieu à des estimations de paramètres clés concernant l'exoplanète 

et son transit. Ces paramètres comprennent : 

1. le carré du rapport du rayon de l'exoplanète (Rp) à celui de son étoile hôte (R*), 

2. le rapport du rayon orbital semi-majeur de l'exoplanète (a) sur R*, 

3. le point central Tc et la durée du transit, 

4. l'inclinaison de l'orbite de l'exoplanète par rapport à la ligne de visée de l'observateur. 

Ainsi, en connaissant le rayon R* de l'étoile hôte de l'exoplanète, l'observateur de l'exoplanète peut alors 

estimer le rayon de l'exoplanète ainsi que le rayon de son orbite semi-principale. 

 

4. Instrumentation 
Le coût est certainement un facteur lors de la sélection du complément d'équipement à utiliser dans 

l'observation de l'exoplanète. Et comme prévu, une plus grande précision exige des équipements plus coûteux. 

Ainsi, le choix de l'équipement (et donc la précision associée à cet équipement) est déterminé principalement 

par des considérations économiques. Cependant, les astronomes amateurs avec un équipement modeste de 

l'ordre de ce qui est typiquement utilisé pour l'imagerie du ciel profond, ont matériellement contribué à la 

science de la détection et du suivi des exoplanètes. 

Comme on le verra, un thème récurrent dans ce Guide est le désir de minimiser le mouvement du champ 

d'étoiles à travers le détecteur CCD pendant une session d'observation de plusieurs heures.  

Ce qui suit décrit donc les caractéristiques de l'équipement qui affectent le plus la précision d'observation de 

l'exoplanète et aident à réduire les effets de la systématique. 

4.1. Montures de télescopes 
Les trois types de montures les plus populaires sont les montures équatoriales allemandes (GEM), les 

montures à fourche et les montures alt-az (altitude-azimut). Des trois, le montage alt-az est le moins 

souhaitable pour l'observation de l'exoplanète en raison des corrections continues qui doivent être faite sur 

trois axes pour garder une étoile relativement dans la même position tout au long de la session d'observation. 
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Ces corrections doivent être effectuées en élévation, en azimut et en angle de position. Évidemment, cela 

signifie que la précision associée aux corrections à l’un de ces trois axes affectera la capacité globale de 

l'observateur à minimiser le mouvement de l'étoile.  

Les corrections d'angle de position, par exemple, sont normalement effectuées par un rotateur et la taille du 

pas incrémentiel du rotateur, ainsi que la cadence de telles corrections affecteront la précision avec laquelle la 

chaîne d'image peut tourner relativement à la même position de pixel tout au long de la session d'observation. 

Les GEM sont des montures économiques et populaires pour l'imagerie planétaire et en profondeur. 

Cependant, les GEM requièrent généralement un retournement méridien lorsque l'étoile cible traverse le 

méridien. Bien que certaines montures GEM puissent continuer à effectuer un suivi pendant un certain temps 

après le méridien, les observations qui nécessitent un suivi plus long nécessiteront finalement un 

retournement méridien. Un flip de méridien entraîne deux facteurs affectant la précision: (1) des points de 

données précieux sont perdus pendant le temps nécessaire au retournement méridien, et (2) sans rotation de 

la chaîne d'imagerie, les étoiles cibles et comparatives tomberont sur la partie du détecteur de la caméra 

d'imagerie qui est diagonalement opposée à l'endroit où ils étaient avant le flip. L'implication de ce dernier est 

que le flux d'étoiles augmenterait ou diminuerait artificiellement à cause de leur atterrissage sur une partie 

d'un beignet de poussière qui n'a pas été complètement corrigé par le champ plat. Même si la chaîne d'images 

était tournée, il serait pratiquement impossible d'obtenir la cible et les étoiles de comparaison sur presque les 

mêmes emplacements de pixel que le pré-flip. Il convient de noter que les logiciels tels que les AIJ peuvent 

aider à compenser les effets d'un retournement méridien, en particulier s'il se produit un peu avant la moitié 

du transit. 

Bien que les montures à fourche soient le support le plus approprié pour l'observation des exoplanètes en 

raison de leur capacité à suivre en continu une étoile cible pendant une longue durée sans avoir à être 

interrompue pour effectuer un flip méridien, les astronomes amateurs et professionnels utilisent tout autant 

les montures GEM pour une observation des exoplanètes de haute précision. 

Quel que soit le type de support utilisé, la précision du suivi est également fonction de toute erreur périodique 

dans les engrenages du support. La correction périodique des erreurs (PEC) et l'autoguidage aideront à 

atténuer ces erreurs périodiques. Il convient de noter qu’aujourd’hui un certain nombre de montures peuvent 

fonctionner pendant plusieurs minutes avec des erreurs minimes, ce qui explique bien sûr leur coût élevé. 

Les meilleures pratiques associées à l'opération de la monture elle-même incluent: 

1. Alignement polaire aussi précis que possible (par exemple, à quelques arc secondes du pôle céleste). 

2. Équilibre de la monture pour aider à réduire les erreurs AD (Ascension Droite) 

3. Dans le cas d'un montage GEM, réduisez le jeu de l’AD en gardant toujours la monture « Coté Est lourd » - 

cela aidera à résoudre toutes les calibration astrométrique (plate solve) qui pourraient être nécessaires après 

un virement méridien pour revenir sur la cible. 

4. minimiser le jeu DEC, ce qui permettrait de meilleures corrections DEC pendant l'autoguidage. 

5. minimiser les erreurs périodiques en vérifiant les grains de vis ou de couronne, ainsi qu'en utilisant le PEC 

pour aider à corriger les erreurs restantes. 
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4.2. Tube optique assemblé (OTA) 
Les meilleures pratiques associées au choix et à la maintenance de l'assemblage de tubes optiques (OTA) du 

télescope sont les suivantes: 

1. L'ouverture compte pour beaucoup, donc plus celle-ci est grande, plus la capacité de collecter des photons 

dans une unité de temps donnée est grande. Ceci est particulièrement important pour les étoiles cibles plus 

faibles. 

2. L'OTA doit être in situ suffisamment longtemps pour être acclimaté à la température de son environnement 

d'exploitation. Cela aiderait à réduire toute turbulence interne de l'air dû aux variations de la température 

dans l'OTA. 

3. Afin de produire une fonction d'étalement de points (PSF) bien formée pour la cible et chaque étoile de 

comparaison, l'OTA devrait être bien collimatée. 

4. Pour les OTA Schmidt-Cassegrain, le miroir primaire doit être verrouillé, si possible, afin de réduire les effets 
du “mirror flop” (mouvement du miroir dû à un lousse). 
 

 

4.3. Caméra d'imagerie 
Plusieurs types de caméras ont été utilisés pour l'observation du transit d'exoplanètes. Ceux-ci comprennent 

des caméras CCD et CMOS autonomes similaires à celles utilisées pour l'imagerie du ciel profond, ainsi que les 

reflex numériques. Cependant, pour effectuer des observations d’exoplanète de niveau scientifique, la caméra 

doit être monochrome. C'est ce qui rend possible l’utilisation de différents filtres photométriques standards. 

Parce que les appareils photo reflex numériques sont intrinsèquement colorés et ne se prêtent donc pas à 

l'utilisation de filtres, ils sont donc le choix le moins souhaitable parmi les caméras d'imagerie. 

Les meilleures pratiques pour choisir une caméra d'imagerie à utiliser dans l'observation d'exoplanètes 

dépendent de facteurs tels que: 

1. Les conditions de visibilité attendues sur le site de l'observateur. Ceci est défini comme le  
« Full-Width-at-Half-Maximum » (FWHM) typique des étoiles mesurées à l'emplacement de l'observateur et 
exprimé en secondes d'arc. 
 
2. La taille (c'est-à-dire le format) du détecteur de la caméra. Bien qu'un format plus grand permette une plus 

grande variété d'étoiles de comparaison, les détecteurs de petits formats ont été utilisés avec succès dans 

l'observation des exoplanètes de niveau scientifique. 

3. Les images de calibration tel que Bias (offset), les dark et Flat (PLU) réduise et purifie le bruit de lecture de la 

caméra. Ces facteurs, cependant, sont beaucoup réduits dans les caméras plus récentes d'aujourd'hui. 

En général, la plupart des caméras d'imagerie monochromes modernes que l'observateur a où va acquérir 

pour d'autres applications telles que l'imagerie du ciel profond, devraient être satisfaisantes pour l'observation 

des exoplanètes. 
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4.4. Autoguidage 
L'autoguidage est essentiel pour l'observation des exoplanètes de qualité recherche afin de minimiser la dérive 

de la cible et des étoiles de comparaison. La dérive due au désalignement polaire, par exemple, provoquera la 

rotation des étoiles sur-le-champ et donc leur mouvement sur-le-champ de vision. Ce mouvement sur une 

image corrigée pas complètement à plat peut sérieusement affecter la précision de l'observation. 

Les approches les plus courantes de l'autoguidage et leurs avantages et inconvénients sont: 

1. Utilisation d’un télescope distinct pour le guidage: cette méthode est la moins souhaitable en raison des 

problèmes de flexion qui peuvent survenir pendant la séance d'observation. 

2. Guidage Off-Axis - bien que fréquemment utilisé par les imageurs de ciel profond pour obtenir des étoiles 

ponctuelles, cette technique entraînera toujours une certaine rotation du champ de la cible et des étoiles de 

comparaison en présence même d'un petit désalignement polaire. Cela est vrai même avec un mouvement 

sous-arc seconde de l'étoile de guidage elle-même. La quantité de rotation de champ (c'est-à-dire la dérive en 

AD et DEC) sera fonction de: 

a. la distance de l'étoile de guidage par rapport à la cible ou des étoiles de comparaison en question; 

b. la quantité de désalignement polaire; 

c. la quantité de mouvement delta de l'étoile de guidage elle-même; 

d. l'angle de déclinaison lors de la prise d'image (le désalignement polaire aura un plus grand impact, 

notamment en RA, lors d'une imagerie à plus forte déclinaison). 

3. Guidage sur l'axe - cette technique emploie un diviseur de faisceau dichroïque pour séparer le trajet de la 

lumière de l'image principale en un trajet infrarouge proche (NIR) et un trajet de lumière visible (di Cicco, 

2012). Ici, la caméra-guide voit, via le trajet infrarouge, une partie de la même image que la caméra d'imagerie 

(en fonction de la taille du détecteur de la caméra guide). Avec cette technique, l'étoile guide est plus proche 

de la cible et des étoiles de comparaison, et donc les effets de tout désalignement polaire sont réduits par 

rapport à l'approche de guidage "Off-axe". En outre, dans le cas des flèches méridiennes avec les montures 

GEM, la même étoile de guidage utilisée avant le flip peut également être utilisée après le flip, éliminant ainsi 

la nécessité d'un rotateur ou d'une recherche d'une autre étoile de guidage, si aucune chaîne d'imagerie la 

rotation a lieu. 

4. Guidage d'image - une technique d'autoguidage relativement nouvelle consiste à effectuer des corrections 

de montage entre les expositions en fonction de la quantité de décalage total de l'image scientifique elle-

même. (Remarque: le terme « image scientifique » est utilisé dans ce guide pour désigner les images brutes du 

champ de vision contenant l'étoile hôte de l'exoplanète, ces images étant aussi souvent appelées lumières par 

d'autres logiciels de traitement d'images). Ceci est en cours de développement (Baudat, 2017), où les 

corrections de montage seront faites lors des expositions des images scientifiques. 

En plus des techniques d'autoguidage ci-dessus, des dispositifs d'optique active (AO) sont également 
disponibles pour l'astronome amateur, de sorte qu'une variété d'erreurs d'engrenage rapides peut être 
corrigée sans faire de "secousse" physique au support. Cette technique utilise un miroir « inclinaison-
inclinaison » ou une fenêtre optique directe qui est dans le chemin optique pour garder une étoile guide 
centrée sans faire de « secousse » physique au support. 
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Le logiciel d'autoguidage est disponible en option pour la plupart des logiciels d'imagerie les plus courants. Un 
logiciel populaire de guide de gratuiciel est PHD2 (voir http://openphdguiding.org). 
 

4.5. Filtres 
Comme mentionné précédemment, il est souhaitable qu'un filtre photométrique standard soit utilisé pour les 

travaux sur les exoplanètes, telles que les filtres Johnson-Cousins U, V, B, Rc et Ic ou les filtres SDSS (Sloan 

Digital Sky Survey), u’, g’, r’ et i’.  Cela est vrai pour au moins trois raisons: 

1. Les coefficients d’assombrissement centre-bord (« limb darkening coefficients ») utilisés pendant le 

processus de modélisation du transit sont fonction du type de filtre (standard), ainsi que des paramètres 

stellaires de l'étoile cible; 

2. Distinguer les transits dus aux binaires éclipsées par rapport aux exoplanètes; utiliser des filtres standard 

alternatifs à travers la session d'observation; la profondeur de transit d’une binaire à éclipse sera 

généralement différente pour deux filtres différents; 

3. les résultats de deux observateurs différents peuvent être mieux comparés. 

Même s'il ne s'agit pas d'un filtre photométrique « standard », un filtre Clear Blue Blocking (CBB), parfois 

appelé « filtre Exoplanète », peut être utilisé pour réduire les effets de la lueur du ciel. 

 

5. Préliminaires 
Cette section traite de certaines des étapes préliminaires qui peuvent être effectuées plusieurs jours avant 

l'observation proprement dite de l'exoplanète, rendant ainsi la session d'observation plus efficace. 

 

5.1. Collecte d'information 
L'annexe A est un exemple de feuille de travail en format Excel que l'observateur peut utiliser pour enregistrer 

certaines informations critiques sur l'observation et fournira également une source d'information pratique 

nécessaire aux AIJ. Les données présentées à l'annexe A servent également d’exemple de bas pour ce guide, à 

savoir la modélisation du transit complet de l'exoplanète WASP-12b. Si aucun changement n'est apporté aux 

instruments ou à l'emplacement de l'observateur, les points 12 à 23 de l'annexe A peuvent être utilisés pour 

plusieurs séances d'observation. 

La dernière version de cette feuille de travail peut être téléchargée à partir de http://www.astrodennis.com . 

La feuille de calcul contient également des liens hypertextes vers des ressources Web où l'utilisateur peut 

obtenir une partie des informations sur les paramètres d'étoiles et d'exoplanètes nécessaires à la phase de 

modélisation du transit, y compris les coefficients d'assombrissement appropriés pour le filtre particulier 

utilisé dans l'observation. 

 

 

http://www.astrodennis.com/
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5.2. Éléments à considérer pour cibler une exoplanète 
Voici des sources utiles pour prédire les transits d'exoplanètes pendant une période de temps donnée à 

l'emplacement d'un observateur en particulier: 

« Archive Exoplanet » de la NASA: http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-

visibletbls?dataset=transits . 

Site Web de la base de données « Exoplanet Transit » (ETD): http://var2.astro.cz/ETD/predictions.php . 

Si l'observateur d’exoplanètes sélectionne lui-même sa cible (c'est-à-dire non spécifiée dans le cadre d'une 

campagne de recherche déterminée), les critères de sélection suivants doivent être considérés afin d’obtenir 

un résultat plus satisfaisant: 

1. Heure du début du transit : comme il est souhaitable que la session d'imagerie commence au moins 30 

minutes avant le début du transit, cela peut annuler certaines exoplanètes candidates dont l'heure de début 

du transit pourrait se produire avant ou même pendant le crépuscule. 

2. Durée du transit : avec certaines durées de transit plus longues que d'autres, l'observateur peut choisir une 

exoplanète candidate dont le temps de session total (compte tenu du besoin d'images 30 minutes après la fin 

réelle du transit) convient à l'observateur. 

3. Magnitude de l'étoile hôte et profondeur du transit : les étoiles hôtes des exoplanètes peuvent varier de 

magnitude V de 8,0 à plus de 13,0, et les immersions de l'étoile en raison du transit de l'exoplanète peuvent 

varier entre les centièmes et les millièmes de magnitude. L'observateur pourrait donc vouloir choisir une 

exoplanète cible dont la baisse prévue de magnitude est supérieure à celle d'une autre cible potentielle. 

Les profondeurs de transit d’exoplanètes sont souvent exprimées en milli-magnitudes (mmag), où 1 mmag = 

0,001 magnitude. Ainsi, une profondeur de transit de 10 mmag est égale à une chute de magnitude de 0,01 ou 

1%. Des profondeurs de transit inférieures à 10 mmag sont réalisables à l'aide de télescopes dont l’ouverture 

est inférieure à 1 m dans des conditions de seeing appropriées. Notez que la relation entre grandeur et flux est 

telle que f1 / f2 = 2.512(m2-m1), où f1 et f2 sont des flux et m1 et m2 sont les magnitudes correspondantes. Ainsi, 

une chute de magnitude de 0,01 équivaut à un changement relatif de 0,009. Du fait que le flux et la magnitude 

à ces petites quantités sont approximativement les mêmes, les changements relatifs de flux sont souvent 

utilisés comme substitut de la magnitude lors de la mesure et en référence à la profondeur de transit. 

5.3. Prédictions du ‘Flip’ du méridien 
L’utilisateur d’une monture équatoriale allemande devrait pouvoir prévoir approximativement le moment 

pendant la séance d’imagerie où, le cas échéant, un virage du méridien pourrait être requis. Cette prévision 

est généralement effectuée en utilisant le logiciel de navigation de l'observateur et informe l'observateur du 

moment où il doit être disponible pendant le retournement du méridien afin d'effectuer le plus rapidement 

possible les ajustements nécessaires pour repositionner le champ de vision du système d'imagerie. 

Les observateurs avec une monture équatoriale allemande peuvent également faire face à un autre problème 

relié à un retournement du méridien. À savoir, s'il n'y a pas de rotation de la chaîne d'imagerie, une nouvelle 

étoile de guidage devra être acquise lorsque le guidage hors axe est utilisé. La section 4.4 a décrit les 

avantages du guidage sur l'axe pour une telle situation.  

http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://var2.astro.cz/ETD/predictions.php
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6. Meilleures pratiques 
Cette section décrit les meilleures pratiques associées à l'observation des exoplanètes. Ces meilleures 

pratiques devraient aider l'observateur d’exoplanètes à obtenir le plus haut niveau de précision pour un 

ensemble d'instruments donné. Elles sont organisées selon la phase respective du processus d'observation de 

l'exoplanète auquel elles s'appliquent. 

 

6.1. Étape de la préparation 
 

6.1.1. Répertoires de fichiers 
Dans l'ordinateur qui exécute le logiciel de capture d'image de l'observateur, il est préférable de configurer les 

sous-répertoires suivants: « Analyse AIJ », « Bias (Offset) », « Darks », « Flat (PLU) », « Images en quarantaine » 

et « Images scientifiques ». Le sous-répertoire « Analyse AIJ » est l'endroit où les fichiers de mesure et de 

modèle d'AIJ peuvent être stockés tandis que les sous-répertoires « Bias », « Darks » et « Flat (PLU) » sont les 

emplacements où les fichiers d'étalonnage respectifs peuvent être stockés. Le sous-répertoire « Images 

scientifiques » inclut les images brutes contenant l'étoile cible et le sous-répertoire « Images en quarantaine » 

permet de parquer les images scientifiques « ratées » dues aux rayons cosmiques, satellites, traînés d’avion, 

etc. Si l'utilisateur souhaite utiliser d'autres noms pour ces sous-répertoires, ceux-ci peuvent être substitués à 

leurs homologues respectifs dans les exemples suivants. 

 

6.1.2. Stabilisation du système d'imagerie à une température appropriée 
Le système d'imagerie doit être mis en place suffisamment à l’avance pour atteindre le degré de température 

désiré, ce qui peut également nécessiter l'activation de son système de refroidissement. 

 

6.1.3. Génération de Flat (PLU) 
Que les Flats (PLU) soient pris durant le crépuscule ou en utilisant un panneau d'électroluminescence, ils 

devraient (idéalement) être refaits avant ou après chaque session d'imagerie en utilisant la même chaîne 

utilisée lors de la prise des images scientifiques et n’ayant subi aucun mouvement ni déplacement. Voir la 

section 6.3.2 pour les directives sur la création des « flats ». 

 

6.1.4. Autoguidage 
L'autoguidage doit être utilisé pendant la phase d'imagerie décrite ci-dessous, à moins que la monture de 

l'observateur soit d’une précision telle qu'elle peut maintenir le guidage à quelques pixels pendant la durée de 

l’observation du transit (où la valeur réelle du mot "quelques" dépend de la FWHM de l'étoile hôte). Voir 

Section 4.4 ci-dessus pour un aperçu des différentes techniques d'autoguidage. Le mécanisme d'autoguidage 

de l'observateur doit être calibré, si ce n'est pas encore fait ou si le logiciel de guidage automatique ne corrige 

pas automatiquement les changements de déclinaison. Si nécessaire, l'étalonnage doit également être fait 

pour tout système d'optique active (AO) utilisé. 
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6.2. Phase d'imagerie 

 

6.2.1. Choix de « Binning » 
La FWHM des étoiles dans le champ cible doit être étalée sur 3 à 5 pixels. Si la caméra d'imagerie est 

normalement configurée pour stocker plus de 1 x 1, il faudra peut-être réduire le binning pour atteindre cet 

objectif. 

Cela conduirait alors à une échelle d'image acceptable (parfois appeler « échelle de l’image » (plate scale) ou 

« échelle de pixel » (pixel plate)). L'échelle de l'image est exprimée en secondes d'arc par pixel et est fonction 

de la distance focale du télescope et de la taille du capteur CCD.  

Par exemple, supposons que le FWHM est de 3,0 secondes d'arc et que l'échelle d'image non définie du 

système d'imagerie de l'observateur est de 0,5 seconde d'arc par pixel. Cela signifie que, sans binning, le 

FWHM serait étalé sur 6 pixels et que le binning 2x2 signifierait que le FWHM soit étalé sur 3 pixels, toujours 

dans la partie acceptable, quoique la plus basse, de la gamme. 

Les étoiles devraient être mises au point de façon précise si ce n'est pour aucune autre raison que pour obtenir 

une mesure précise de FWHM. Cependant, si l'étoile cible est trop brillante et risque de saturer la caméra 

d'imagerie, il peut être nécessaire de défocaliser l’OTA. Si le fond du ciel n'est pas trop élevé, la défocalisation 

qui résulte en un PSF* de 10-20 pixels qui est acceptable, tant que cette défocalisation n'entraîne pas le flux 

d'une étoile proche se confondant avec le flux de l'étoile cible. 

* PSF : Point Spread Function = Fonction d’étalement du point. 

 

6.2.2. Choix du temps d'exposition 
Le temps d'exposition optimal est celui qui maximise le SNR* de l'étoile cible, sans saturer le détecteur de la 

caméra d'imagerie.   *SNR : Signal Noise Ratio = Rapport Signal / Bruit 

 

Pour une étoile cible donnée, les facteurs qui affectent le temps d'exposition optimal incluent : 

1. Le diamètre d’ouverture du télescope, 

2. Le filtre utilisé, 

3. L'efficacité quantique ou rendement quantique (QE) de la caméra d'imagerie, 

4. Si l'étoile monte au méridien local, ou a passé le méridien et redescend, 

5. Les conditions climatiques et atmosphériques (« Seeing »). 

Les capteurs CCD d'aujourd'hui ont spécifiquement une portée linéaire jusqu'à un point donné, après quoi ils 

deviennent non linéaires et deviennent saturés à un moment précis (Anti-Blooming). À leur point de 

saturation, tout photon supplémentaire frappant le pixel ou photosite du CCD ne sera pas enregistré. Ainsi, il 

est essentiel que les étoiles cibles et de comparaisons n'atteignent jamais la saturation et, idéalement, 

n'atteignent pas non plus la non-linéarité (il faut cependant noter que des logiciels tels que les AIJ permettent 

d'effectuer des corrections de non-linéarité). Il est important que le temps d'exposition soit choisi de façon à 

obtenir un SNR convenable, mais pas trop long pour ne pas empêcher la non-linéarité ni la saturation de se 

produire. Si l'étoile cible est censée s'élever vers le méridien local et donc sa lumière passera devant de moins 
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en moins de masse d'air, l'une ou l'autre de ces deux situations pourrait alors se produire. 

Ainsi, l'observateur doit également prendre cela en considération lors du choix d'un temps d'exposition. Notez 

que la défocalisation pourrait également aider cette situation. 

Afin d’établir dès le départ le temps d'exposition approprié, une série d'images de test doit être prise avec un 

temps d'exposition croissant. Le rapport signal sur bruit de l'étoile cible, ainsi que le nombre d'ADU, pourrait 

ensuite être mesuré pour chaque paramètre d'exposition. La section 7.5.1 décrit comment AIJ peut être utilisé 

pour déterminer le SNR d'une étoile. Un paramètre d'exposition qui maximise le rapport signal / bruit, mais 

qui ne présente pas de potentiel de saturation pendant la séance d'imagerie, devrait alors être considéré 

comme le temps d'exposition idéal. 

La procédure de bonne pratique suivante, effectuée immédiatement avant la séance d'observation, est 

recommandée pour déterminer le temps d'exposition optimal: 

1. À la position actuelle de l'étoile cible dans le ciel, prenez des images de test à différents temps d'exposition. 

Tout d'abord, sélectionnez le temps d'exposition avec le SNR le plus élevé pour l'étoile cible, où le nombre 

maximal d'ADU est inférieur à 75% du point de saturation du détecteur de la caméra d'imagerie. Notez que 

cette limite de 75% peut devoir être réduite si l'on s'attend à ce que la caméra atteigne la non-linéarité 

beaucoup plus tôt. 

2. Si l'étoile monte vers le méridien local, réduisez le temps d'exposition de sorte que le détecteur n'atteigne 

pas la saturation. 

3. Si l'étoile descend du méridien local, augmentez le temps d'exposition de telle sorte que le nombre maximal 

d'ADU de l'étoile cible soit égal à 75% du point de saturation du détecteur. 

Il y a des situations où l'équipe de scientifique professionnelle peut exiger une certaine cadence d'images, ce 

qui peut se faire au détriment du temps d'exposition optimal. Cela peut être le cas lorsque des détails plus fins 

du motif de la courbe de lumière sont plus importants que la précision de la profondeur de la courbe de 

lumière elle-même. 

6.2.3. Synchronisation de l'heure 
En raison de la dérive naturelle de l'horloge de l'ordinateur de capture d'image, il devrait être fréquemment 

synchronisé avec le serveur de temps Internet de l'Observatoire naval américain. Cela peut être fait en 

utilisant un logiciel gratuit tel que Dimension 4 (voir http://www.thinkman.com/dimension4/) .  

La période de mise à jour de ces synchronisations d'horloge doit être définie au moins toutes les 2 heures. 

6.2.4. Système de temps 
En raison de l'existence de plusieurs systèmes d’heures différents, l'observateur d’exoplanètes doit savoir 

lequel est utilisé pour la prévision de transit, lequel est entré dans les en-têtes FITS d'image, lequel est utilisé 

pendant le processus de modélisation de la courbe de lumière, etc. Les systèmes de temps les plus 

couramment utilisés sont les suivants: 

a) Date julienne / Heure universelle coordonnée (JDUTC), 

b) Date héliocentrique julienne / Heure universelle coordonnée (HJDUTC), 

c) Date barycentrique julienne / Heure dynamique barycentrique (BJDTDB). 

http://www.thinkman.com/dimension4/
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Si les résultats de l'observation de l'exoplanète doivent être utilisés dans une collaboration 

professionnelle/amateur, BJDTDB serait la norme de temps souhaitée à utiliser pendant le processus 

d'ajustement du modèle. Les sections 7.2.2 et 7.6 décrivent comment AIJ peut convertir l'heure des images 

capturées en heure BJDTDB. 

 

6.2.5. Température de fonctionnement 
Le système d'imagerie doit être mis dans son environnement d'exploitation avec suffisamment de temps pour 

atteindre un point de consigne de température aussi basse que possible, ce qui peut également nécessiter 

l'activation de son système de refroidissement. 

 

6.2.6. Capture d'image 
Le logiciel normal de capture d'image de l'observateur est utilisé pour capturer les images scientifiques dans le 

sous-répertoire Science Images pendant cette phase. Si un flip méridien est nécessaire pendant la session 

d'imagerie, alors au moment où le flip méridien se produit, l'observateur doit: 

1. Abandonner le logiciel de capture d'image 

2. Arrêtez l'autoguidage 

3. Exécutez le flip du méridien 

4. Repositionnez l'étoile cible si nécessaire dans le champ de vision de l'appareil photo 

5. Activer l'autoguidage 

6. Activez le logiciel de capture d'image. 

 

6.3. Phase d'étalonnage de l'image 

6.3.1. Fichiers de calibrage 
Avant ou après la capture d'images scientifiques, l'utilisateur capturera également une série de fichiers 

d'étalonnage d'observations, des images de Flat (PLU), darks et d’offset (bias), et les stockera dans leurs sous-

répertoires respectifs. Une règle empirique consiste à capturer (idéalement) un nombre impair d'images pour 

chaque série de calibrage. Un nombre impair est suggéré, car cela permet une combinaison médiane plus tard 

pour créer le maitre dark, maitre flat (PLU) et maitre offset. Dans tous les cas, au moins seize (16) images 

doivent être capturées pour chaque type de fichier d'étalonnage. 

Les lignes directrices pour les temps d'exposition pour chacun de ces types de fichiers d'étalonnage sont les 

suivantes: 

1. Les Darks : le temps d'exposition doit être égal à celui des images scientifiques et doit être pris à la même 

température que celles-ci. 

2. Les Flats (PLU) : le temps d'exposition dépend de la technique de « flat » utilisée, mais prend généralement 

3 secondes ou moins. Cependant, ce temps d'exposition peut devoir être augmenté pour les caméras dotées 

de volets automatiques, de sorte qu'aucun ombrage de l'obturateur ne se produise. Une règle empirique 
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consiste à créer des trames de « flat » de sorte que l'histogramme résultant soit à mi-chemin dans la plage 

dynamique du détecteur CCD. Par exemple, pour un détecteur avec un nombre ADU maximum typique de 65 

000, la luminosité de la source lumineuse serait réglée de sorte que le centre de l'histogramme résultant soit à 

32 000 ADU. Comme indiqué dans la section 6.3.2 ci-dessous, une attention particulière est nécessaire pour la 

création de « flats ». 

3. Les Bias (offset) : un fichier de polarisation est un fichier sombre d'une durée d'exposition de 0 seconde. 

Généralement, des « flats-dark » sont également créés, car les Flat contiennent aussi eux-mêmes du bruit 

électrique qui doit être soustrait. Lorsqu'ils sont utilisés, les « flats-dark » sont pris avec la même durée 

d'exposition que les « flats » eux-mêmes. Cependant, comme on le verra dans la section 7.2 ci-dessous, une 

technique employée par AIJ pour mettre le maitre Dark à la même durée d'exposition que le maitre Flat évite à 

l'utilisateur de générer des « flats-dark ». 

 

6.3.2. Techniques d’imagerie Flat (PLU) 
Comme le mouvement des étoiles sur quelques pixels est inévitable, même avec un alignement automatique 

et un alignement polaire assez précis, on s'attend à une correction pour atténuer les effets des beignets de 

poussière et du vignetage. Par exemple, la figure 1 représente une image de Flat (PLU) et le mouvement 

potentiel d'une étoile sur un beignet à proximité de la poussière. La figure 2 illustre ce qui se passerait dans le 

cas d'un retournement méridien, à savoir que l'étoile basculerait sur la diagonale du détecteur et atterrirait sur 

un autre « beigne » de poussière. Si la correction du « flat » n'est effectuée pour aucun de ces deux cas, le flux 

de l'étoile en question changerait artificiellement. 

 

Figure 1. Mouvement d'étoile dans une image Flat (PLU) non corrigé. 
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Figure 2. Mouvement d'étoile après un changement de méridien 

 

Les « images Flat » devraient idéalement être créés avant ou après chaque séance d'observation, et 

certainement quand il y a un changement dans la chaîne d'imagerie. 

Voici des techniques courantes pour générer des flats à partir desquels un Flat (PLU) modèle peut être créé: 

1.  Flat (PLU) crépusculaires : Les images de flats sont prises à l'aube et/ou au crépuscule. En raison de la 

vitesse de changement d’éclairage du ciel, il est souvent fastidieux de prendre une bonne série de « flats », 

surtout si cela doit se faire avec plusieurs filtres. Dans certains cas, les « flats » peuvent montrer des étoiles si 

le temps d'exposition est trop long. Des diffuseurs maison utilisant un T-shirt blanc ont été un moyen 

populaire pour atténuer ce problème. 

2. Boîtes lumineuses - des boîtes à lumière faite maison ont été utilisées par certains astronomes amateurs 

pour créer des « flats ». Cependant, l'utilisation de cette technique pour produire un champ lumineux 

uniforme est parfois difficile à réaliser. 

3. Panneaux d'électroluminescence - bien qu’elle nécessite un certain déboursé, la technique a plusieurs 

avantages: elle permet de créer un champ de lumière relativement uniforme, sa luminosité peut être modifiée 

pour accueillir divers filtres, et les « flats » peuvent être pris à la convenance de l’observateur. 

4. Les Flats (PLU) de l'observatoire - cette technique utilisée dans les observatoires permanents consiste à 

pointer le télescope vers un panneau blanc éclairé sur le mur de l'observatoire. L'efficacité de cette technique 

varie largement avec la nature du panneau blanc, l'éclairage ambiant, etc. 
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6.3.3. Création de fichiers maîtres 
L'étalonnage de l'image élimine les effets des facteurs sous-jacents suivants qui affectent la précision des 

mesures: offset, bruits électriques, et les beignes ou traces de poussières et vignettage. Les suivants sont les 

meilleures pratiques pour traiter chacun de ces facteurs : 

1. Les fichiers d’offset devraient être pris à un certain moment avant ou après la séance d'observation. Ceux-ci 

sont utilisés pour créer un fichier d’offset maître, idéalement en utilisant une combinaison médiane. 

2. Les fichiers de Dark doivent être pris à la fin de la séance d'observation. La raison de les prendre à la fin de la 

séance d'observation est de s'assurer qu'ils sont pris à la même la température comme les images de la 

science. Un fichier « dark » maître est ensuite créé à partir d'eux, à nouveau en utilisant la combinaison 

médiane.  

3. Les fichiers Flats (PLU) doivent être pris au début ou à la fin de la séance d'observation. Puisque les fichiers 

Flat (PLU) sont eux-mêmes bruités et ont un temps d'exposition différent de celui des images scientifiques, ils 

ont besoin qu’un dark leurs soit appliqué. Plutôt que de créer un fichier dark maître spécifiquement afin 

d’obtenir une correction pour les Flat (PLU) une autre approche serait d'utiliser le même fichier dark maître 

créé pour les images scientifiques, mais en suivant le temps d'exposition requis pour les fichiers Flats. Un 

logiciel tel que AIJ, a cette fonction de mise à l'échelle. La section 6.3.2 ci-dessus décrit les meilleures pratiques 

pour créer des fichiers Flats. 

 

6.3.4. Mise à jour des informations d'en-tête FITS 
Pendant la phase d'étalonnage de l'image, certains logiciels tels que AIJ permettent à l'utilisateur de mettre à 

jour le « FITS Header » des images scientifiques avec des informations telles que le temps BJDTDB de 

l'observation. S'il n'est pas inclus dans l'en-tête FITS par le logiciel de capture d'image, d'autres informations 

importantes telles que le « AIRMASS » peuvent également être insérées.  Comme on le verra plus tard, le 

« AIRMASS » est l'un des paramètres les plus fréquemment utilisés pendant la modélisation du processus du 

transit. 

 

6.4. Phase d'ouverture et de photométrie différentielle 
Comme il a été mentionné à la section 3, la méthode de transit des exoplanètes consiste à comparer le 

changement de luminosité entre l'étoile cible et un ensemble d'étoiles de comparaison appropriées. Avant que 

cette comparaison puisse être cependant faite, la luminosité de chaque étoile doit être ajustée pour le 

comptage de photons en raison du ciel en arrière-plan qui pourrait affecter chaque étoile en particulier. Ceci 

est fait en utilisant la photométrie d'ouverture. Une fois cette tâche accomplie, la variation relative du flux 

(ajusté) entre l'étoile hôte et les étoiles de comparaison peut alors être obtenue. Ce processus est appelé 

photométrie différentielle. Les meilleures pratiques associées à l'ouverture et à la photométrie différentielle 

sont décrites ci-dessous. 
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6.4.1. Photométrie d'ouverture 
La photométrie d'ouverture consiste à définir à la fois « l’ouverture » d'un certain rayon autour d'une étoile, 

ainsi qu'un "anneau" extérieur. L'idée de l'anneau est de mesurer le fond du ciel autour de l’étoile. La figure 3 

représente une ouverture de rayon 9 et un anneau commençant à 16 pixels du centroïde de l'étoile et se 

terminant à l'emplacement du pixel 24. 

 

Figure 3. Ouverture et anneau 

 

Afin de compenser l’effet du ciel en arrière-plan, les comptages d'ADU par pixel dans l'anneau sont utilisés 

pour ajuster les ADU dans l'ouverture. Certains logiciels tels que AIJ ont également la capacité de détecter et 

s’ajuster aux étoiles faibles qui pourraient se trouver dans l'anneau et donc mesurer le fond du ciel. Comme 

cela sera décrit ultérieurement, les réglages de rayon initialement fixés pour l'ouverture et l'espace annulaire 

peuvent être modifiés après qu'un ajustement de modèle d'exoplanète soit effectué pour optimiser davantage 

l'ajustement. 

La section 7.5.1 décrit comment AIJ peut être utilisé pour sélectionner la taille initiale de l'ouverture et de 

l'espace annulaire. 

 

6.4.2. Photométrie différentielle 
La photométrie différentielle consiste à appliquer une photométrie d'ouverture sur l'étoile cible et plusieurs 

étoiles de comparaison, puis à comparer les différences relatives du flux (ajusté). Voici les meilleures pratiques 

pour sélectionner des étoiles de comparaison appropriées : 

1. Idéalement, il faudrait choisir au moins 8 étoiles de comparaison dont l'amplitude est aussi proche que 

possible de celle de l'étoile cible, c'est-à-dire ne dépassant pas 0,75 de magnitude (c'est-à-dire plus faible) et 

pas moins de 0,44 de magnitude) que l'étoile cible. Si cela n'est pas possible, alors un ensemble d'étoiles de 

comparaison devrait être sélectionné de telle sorte que la moyenne de leur nombre d'ouvertures soit proche 

de celle de l'étoile cible. 

2. Les étoiles de comparaison devraient idéalement être de type stellaire similaire à l'étoile cible afin de 

minimiser les différences d'extinction atmosphérique. Cependant, si le logiciel de modélisation de transit est 
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capable de « détruire » les effets du « AIRMASS », comme c'est possible avec AIJ, il est plus important de 

choisir des étoiles de comparaison de luminosité similaire à l'étoile cible que de choisir des étoiles de type 

stellaire similaire. 

3. Les étoiles de comparaison ne doivent pas être intrinsèquement variables. Ceci peut être déterminé 

ultérieurement en visualisant la courbe de lumière de chaque étoile de comparaison comme décrite dans la 

section suivante ou en utilisant les informations de l'utilitaire « Variable Star Plotter (VSP) » de l'AAVSO. 

Les résultats de la phase de photométrie différentielle seront un fichier de mesures qui a pour chaque image 

minimalement : l'horodatage de l'image, le changement de flux ou de magnitude de l'étoile cible (par rapport 

aux étoiles de comparaison) et les erreurs associées. Selon le logiciel de photométrie différentielle, d'autres 

données précieuses pourraient inclure le changement relatif du flux ou de la magnitude de chaque étoile de 

comparaison (par rapport à toutes les autres étoiles de comparaison), leurs erreurs associées et les 

changements des coordonnées X et Y de la cible et les étoiles de comparaison. 

 

7. Utilisation d'AstroImageJ 
 

Le reste de ce guide décrit l'utilisation d'AIJ pour le post-traitement d'images scientifiques et pour l'ajustement 

de modèles d'exoplanètes. L'utilisation de AIJ suppose que l'utilisateur a déjà installé AIJ sur son poste de 

travail et a lu le guide de l’usager de AIJ, disponible sur: http://www.astro.louisville.edu/software/astroimagej/  

L'utilisateur est invité à rechercher régulièrement une mise à jour du logiciel AIJ. Ceci est fait en cliquant sur 

« Help » dans le coin supérieur droit de la barre d'outils AIJ principale (voir Figure 4), puis en sélectionnant 

« Update AstroImageJ ». 

 

 

 

Figure 4. Barre d'outils AIJ 

Les données des transits réels d'exoplanètes seront utilisées dans les exemples dans le reste de ce guide. Les 

fichiers de calibrage et les images originales de l'exemple WASP-12b peuvent être trouvés sur 

http://astrodennis.com. 

 

 

 

 

http://www.astro.louisville.edu/software/astroimagej/
http://astrodennis.com/
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7.1. Chargement des images dans AIJ 
Une seule image autant qu’une séquence d'images peut être chargée dans AIJ. 

Pour ouvrir une seule image, sélectionnez File-> Open dans la barre d'outils AIJ (Figure 4), puis sélectionnez le 

répertoire et fichier désiré. La fenêtre d'affichage de l'image (voir Figure 5) apparaît alors. Un exemple 

d'informations utiles pouvant être obtenues de n’importe laquelle des images scientifiques et qui contenu 

dans son en-tête FITS. Cette information peut être obtenue en sélectionnant l'en-tête « Edit-> FITS Header » 

en haut de la fenêtre d'affichage de l'image. La plupart des opérations sur la fenêtre d'affichage des images, 

décrites ci-dessous pour une séquence d'images peuvent également être appliquées à une seule image. 

 

 

Figure 5. La fenêtre d'affichage de l'image 
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Un ensemble d'images peut être chargé dans ce qu'on appelle un « stack » ou une « pile » AIJ. Chaque image 

de la pile est appelée « slice ou tranche ». La pile est un ensemble actif d'images auxquelles différentes 

fonctions AIJ peuvent être appliquées. À partir de la barre d'outils AIJ, sélectionnez « File-> import-> Image 

Sequence », puis sélectionnez UN fichier dans le sous-répertoire contenant les images scientifiques calibrées 

(remarque : n'essayez pas de sélectionner une plage d'images, il suffit de sélectionner l'un des fichiers dans le 

sous-répertoire). Un écran similaire à celui de la figure 6 apparaît. 

 

 

Figure 6. Fenêtre Options de séquence 

 

Si l'ordinateur exécutant AIJ dispose d'une mémoire insuffisante pour contenir toutes les images de la pile, la 

sélection "Use virtual stack" sur la fenêtre Options de séquence peut être désactivée, ce qui entraîne un 

démarrage plus rapide de l'image, car les images peuvent être directement accessibles depuis la mémoire. Si 

un message de mémoire insuffisante apparaît encore dans ce cas, alors une configuration peut allouer plus de 

mémoire à AIJ en procédant comme suit: 

1. À partir de la barre d'outils AIJ principale, allez dans Edit-> Options-> Memory and Threads ... 

2. Modifiez la valeur de la mémoire maximale sur une valeur plus grande. 

Ensuite, avec les cases cochées comme sur la figure 6, à l'exception possible de la sélection de la pile virtuelle, 

sélectionnez le bouton OK. Cela crée une pile AIJ des images scientifiques calibrées. L'affichage de l'image 

(Figure 5) montre ensuite la première image de la pile. 
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7.2. Étalonner les images scientifiques 
La fonction Data Processor (DP) de AIJ peut d'abord être utilisée pour calibrer les images scientifiques prises 

pendant la phase d'imagerie. Remarque : avant de procéder à cette section, il est fortement suggéré que le 

lecteur examine la section 6 (Interface utilisateur DP) du Guide de l'utilisateur de AIJ. La fonction DP est lancée 

en cliquant sur l'icône de la barre          d'outils principaux de AIJ. La figure 7 est un exemple de l'un des deux 

fenêtres qui apparaît alors. 

 

Figure 7. La fenêtre du « CCD Data Processing » 

 

Un exemple de l'autre fenêtre qui apparaît est représenté sur la figure 8, qui peut initialement couvrir La fenêtre 

« CCD Data Processor ». 
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Figure 8. Fenêtre du convertisseur de coordonnées DP (DP Coordinate Converter) 

 

Le but de la fenêtre du processeur de données CCD est de calibrer les images scientifiques en utilisant les fichiers 

d’offset, de Dark et de Flat (PLU) précédemment capturés. Il existe cependant plusieurs façons de créer les 

fichiers de offset maître, les fichiers dark et Flat (PLU) utilisés pour l'étalonnage. Par exemple, les fichiers maîtres 

peuvent être créés dans des exécutions séparées du processeur de données CCD, puis une exécution finale 

spécifie les fichiers maîtres utilisés. De plus, l'utilisateur peut utiliser d'autres programmes pour effectuer 

l'étalonnage et peut simplement décider d'utiliser AIJ pour mettre à jour les en-têtes FITS des fichiers calibrés, 

ce qui est décrit ci-dessous. Dans l'exemple représenté sur la figure 7 et décrit ci-dessous, AIJ utilise un cycle 

pour accomplir tout : les fichiers maîtres sont d'abord créés à partir d’offset individuels, de fichiers dark et Flat 

(PLU), ces fichiers maîtres servent à calibrer les 336 images scientifiques, les en-têtes FITS des fichiers calibrés 

résultants sont mis à jour. Dans l'exemple ci-dessous, les fichiers dark originaux et les images scientifiques 

avaient un temps d'exposition de 45 secondes et les fichiers de "flat" avaient un temps d'exposition de 3 

secondes. 
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7.2.1. Spécification d'images scientifiques et de fichiers de calibrage 
La première étape de l'étalonnage de l'image consiste à spécifier où AIJ peut trouver les images scientifiques et 

les fichiers d'étalonnage. Sous la section Traitement de l'image de la science sur la fenêtre du processeur de 

données CCD, les cases « Enable » et « Sort Num » sont cochées et le répertoire est saisi où se trouvent les 

images scientifiques (en cliquant sur l'icône du dossier et en sélectionnant le sous-répertoire approprié). Ensuite, 

l'extension de fichier appropriée avec l'indicateur générique « * » pour le chemin du nom de fichier est entrée. 

Si le chemin d'accès au nom de fichier et l'extension des images scientifiques ont été correctement saisis, le 

comptage total vers la droite doit être correct. 

La méthode ci-dessus devrait également être utilisée pour spécifier les sous-répertoires et les extensions de 

fichiers pour les fichiers offset, dark et Flat (PLU). Pour chacun de ces ensembles de fichiers de calibrage, un 

sous-répertoire et un nom de fichier complet (et non seulement une extension) doivent être entrés pour leurs 

fichiers maîtres respectifs à créer. Par exemple, sur la figure 7, un fichier maître dark appelé mdark.fits sera créé 

dans le même sous-répertoire où les Flat-darks individuelles sont trouvées. 

Les cases à cocher créées et activées pour chacun des types d'étalonnage doivent également être cochées, et le 

choix de combiner la moyenne (ave) ou la médiane (med) doit être utilisé pour créer les fichiers maitres. Si les 

Flat-darks doivent être mises à l'échelle et utilisées comme des Flat-darks, les cases «scale» et «deBias» doivent 

être sélectionnées.  

Il y a des variantes à ce qui précède. Par exemple, pour utiliser des fichiers maîtres déjà créés, les cases "Build" 

ne doivent pas être sélectionnées. 

Remarque: Il est important que l'option " Remove Outliers » (supprimer les valeurs aberrantes) ne soit PAS 
sélectionnée lorsque la photométrie différentielle est en cours et que « Polling Interval » sous le Panneau de 
configuration soit réglé sur 0. Aussi, sauf si l'option "Activer" pour « Filename Number Filtering » ou les 
options "Enable Linearity Correction " sont utilisées (voir Section 6.3.2.1 et Section 6.3.2.5, respectivement au 
Guide de l'utilisateur AIJ), conséquemment elles ne devraient pas être activées. 
 

7.2.2. Mise à jour des informations d'en-tête FITS 
AIJ a deux méthodes pour obtenir des informations essentielles telles que l’AIRMASS, BJDTDB, etc., qui seront 
utiles pendant la phase de photométrie, du graphique et de modélisation. La première méthode consiste à 
mettre à jour le fichier de mesures créé après l'application d'une photométrie différentielle aux images 
calibrées. Cette méthode est décrite dans la section 7.6 ci-dessous. Cette méthode ne met toutefois pas à jour 
les en-têtes FITS des fichiers calibrés, de sorte que chaque fois qu'une nouvelle mesure de photométrie 
différentielle est effectuée sur les images calibrées, cette mise à jour devrait avoir lieu à nouveau. Il convient 
de noter que certains logiciels de capture de caméra incluront l’AIRMASS dans l'en-tête FITS, mais 
probablement pas le BJDTDB. 
 
La deuxième méthode, qui se déroule pendant la phase d'étalonnage, consiste à inclure cette information 
directement dans les en-têtes FITS des fichiers calibrés. Ainsi, au moment où les fichiers d'étalonnage sont 
corrigés avec des fichiers Bias (offset), des Dark et des Flats (PLU), leurs en-têtes FITS sont également mis à 
jour.  
 
Des deux méthodes, celle-ci est la préférée, car de multiples opérations de modélisation peuvent être 
effectuées avec différents paramètres de photométrie, sans avoir à mettre à jour le fichier de mesures après 
chaque exécution avec des informations telles que l’AIRMASS et BJDTDB. 
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Pour mettre à jour les en-têtes FITS pendant le processus d'étalonnage, l'utilisateur doit sélectionner General 
dans la section Mises à jour de l'en-tête FITS de la fenêtre Processeur de données CCD (voir Figure 7). La 
fenêtre « DP Coordinate Converter » apparaît alors (Figure 8), s'il n'est pas déjà ouvert. 
 
Pour mettre à jour les en-têtes FITS, AIJ a besoin des coordonnées DA et DEC de la cible, ainsi que de l'endroit 
où l'observation a été effectuée. Cette information peut être saisie manuellement, ou AIJ peut extraire 
automatiquement ces données des en-têtes FITS si elles ont été incluses dans le logiciel de capture d'image de 
l'utilisateur. 
 
 

7.2.2.1. Entrée des informations de localisation de cible et d'observation 
Dans le cas d'une saisie manuelle, des coordonnées de la cible et/ou de l'emplacement d'observation, 
l'utilisateur sélectionnera l'entrée manuelle de la fenêtre «DP Coordinate converter »  
 
De la fenêtre «DP Coordinate converter », l’utilisateur sélectionne « Coordinate Converter manual entry » 
sous la case « Target Coordinate Source » ou sous la case « Observatory Location Source ».  
 
Puis sur la fenêtre «DP Coordinate converter », des champs ont été activés et l'utilisateur saisit alors les 
valeurs désirées,  Lon (Longitude), Lat (Latitude) et Alt (Altitude) dans la section Localisation géographique de 
l'observatoire et/ou saisit les champs AD et DEC de la cible dans la section équateur J2000. 
 
Si les coordonnées AD et DEC font déjà partie de l'en-tête FITS de l'image, l'utilisateur sélectionne "FITS header 
target RA / DEC (2000)" dans la zone « Target Coordinate Source ». Si l'emplacement d'observation fait déjà 
partie de l'en-tête FITS de l'image, l'utilisateur sélectionnera « FITS header longitude and latitude » dans la 
zone « Observatory Location Source ». 
 

7.2.2.2. Mises à jour dynamiques 
Quelle que soit la méthode utilisée par AIJ pour obtenir les coordonnées de la cible et le lieu d'observation, 
l'utilisateur doit effectuer les opérations suivantes sous la section Temps dynamique de la fenêtre «DP 
Coordinate converter »: 
 

1. Auto devrait être sélectionné. 
2. Le bouton Mettre à jour doit être cliqué. 

 
Ces actions permettront à AIJ de comptabiliser le nombre approprié de secondes supplémentaires lors des 
conversions de temps à BJDTDB. 
 

7.2.2.3. Autres informations requises Informations d'en-tête 
Ensuite, il est important que les images scientifiques brutes contiennent dans leurs en-têtes FITS des 
informations sur la date et l'heure du début de l'observation ainsi que sur le temps d'exposition. Les sections 
6.3.2.6.1 et 6.3.2.6.2 du Guide de l'utilisateur des AIJ décrivent les mots-clés d'en-tête FITS acceptables qu’AIJ 
peut utiliser pour obtenir cette information. 
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7.2.2.4. Ajuster les paramètres d'en-tête 
Une fois les informations de l'observatoire et de la cible remplies, et confirmant que les entêtes FITS 

contiennent des informations de date / heure et d'exposition acceptables, l'utilisateur sélectionnera l'icône sur 

la fenêtre du processeur de données CCD. La fenêtre General FITS Header Settings apparaît alors (Figure 9). 

 

Figure 9. Fenêtre des paramètres généraux de l'en-tête FITS 

 

Si la méthode d'entrée automatique a été utilisée pour les coordonnées cibles, les mots clés appropriés dans 

l'en-tête FITS de l'image associés à cette information doivent être inclus dans les entrées de mot clé RA (AD) 

cible et cible (Figure 9). Les paires de mots-clés communs pour cette information sont: RA_OBJ, DEC_OBJ et 

OBJCTRA, OBJCTDEC; cependant, l'utilisateur doit confirmer quelle paire de mots-clés est placée dans l'en-tête 

FITS des images par le logiciel de capture d'image de l'utilisateur. 

De même, si la méthode d'entrée automatique a été utilisée pour l'emplacement d'observation, les mots clés 

appropriés dans l'en-tête FITS de l'image associés à cette information doivent être inclus dans les entrées Mot-

clé Observation Latitude et Observation Longitude. SITELAT et SITELONG sont de tels mots-clés. REMARQUE: 

certains logiciels de capture d'image, tels que Sky X Pro, peuvent inscrire un nombre positif dans l'en-tête FITS 

pour la longitude, même s'il s'agit d'une longitude ouest (la longitude ouest est généralement signalée par un 

signe négatif Elongitude - à savoir, les degrés totaux à partir de 0 longitude.). Si la longitude ouest est un 

nombre positif dans l'en-tête FITS de l'utilisateur, l'utilisateur doit alors cocher la case « annuler » pour 

indiquer à AIJ que le numéro trouvé dans l'en-tête FITS doit avoir un signe négatif associé. 

La partie Paramètres de sortie d'en-tête FITS de la fenêtre indique les éléments qui seront ajoutés aux images 

calibrées (indiquées par celles qui ont été activées). Note: il est suggéré que tous les mots clés restent 

"activés" (enable). 
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7.2.2.5. Information WCS 
Enfin, bien que cela ne soit pas fait dans cet exemple, les valeurs du système de coordonnées mondiales (WCS) 

pour chaque étoile de chaque image peuvent être obtenues en sélectionnant l'option de calibration 

astrométrique (Plate Solve) sur la fenêtre « CCD Data Processor ». Il convient cependant de noter que ce 

processus peut prendre beaucoup de temps et n'est pas nécessaire dans de nombreux cas (voir la section 7.4 

ci-dessous pour l'obtention de coordonnées WCS pour des images sélectionnées). 

7.2.3. Commencer le processus d'étalonnage 
À titre d'exemple, lorsque le bouton START est sélectionné, la routine DP exécute automatiquement les étapes 

suivantes: 

1. Créer un fichier offset maître (mbias.fits) à partir des 16 fichiers de biais. 

2. Créez un maitre Dark (mdark.fits) à partir des 16 fichiers Darks. Corrigez ce maitre Dark avec le maitre Bias. 

Ainsi, le maître Dark sera soustrait du Bias. 

3. Créez un maitre Flat (mflat.fits) en utilisant les 16 fichiers plats de la manière suivante: 

a. calculer d'abord un facteur d'échelle qui représente le rapport entre les temps d'exposition des flats 

(PLU) et le temps d'exposition des fichiers Darks d'origine (dans cet exemple, le facteur d'échelle serait 

0,0667 = 3 s / 45 s); 

b. effectuer une correction d’offset en utilisant le fichier d’offset principal; 

c. effectuer une correction dark à l'aide du maitre Dark; 

d. supprimer les dégradés; 

e. normaliser les « flats (PLU) » calibrés. 

4. Les en-têtes FITS des fichiers calibrés sont mis à jour. 

5. Étalonnez chaque image de science en utilisant les fichiers offset Maître, maitre Dark et maitre Flat. Un 

affichage d'image est visible pour chaque image lors de son calibrage. 

6. Les images scientifiques calibrées sont stockées dans un sous-répertoire de calibrage sous le sous-répertoire 

contenant les images scientifiques. Dans cet exemple, le sous-répertoire sera appelé « pipeline out » et ses 

fichiers auront un suffixe de _out. 

7.2.4. Opération en temps réel 
En plus d'effectuer un calibrage d'image après observation, AIJ est également capable de fonctionner en temps 

réel si l'intervalle d'interrogation est réglé sur une valeur non nulle. Dans ce cas, à la fréquence d'interrogation 

spécifiée, AIJ vérifiera automatiquement l'image scientifique pour un motif spécifié sur la fenêtre du 

processeur de données CCD. AIJ les étalonnera, effectuera éventuellement une photométrie différente et 

mettra éventuellement à jour la courbe de lumière (voir les cases à cocher « Post Processing » sur la fenêtre 

« CCD Data Processor » pour sélectionner ces options). 

 

7.2.5. Options additionnelles 
La section 6 du Guide de l'utilisateur AIJ fournit d'autres options disponibles pour la fenêtre « CCD Data 

Processor ». 



Guide pratique de l'observation des exoplanètes | Révision 3.1 Septembre 2017__________________________                                                        

28 
 

7.3. Chargement des images de calibrage 
Après le calibrage, les images du sous-répertoire de calibrage peuvent être chargées dans AIJ (voir la section 

7.1 sur la façon de charger un ensemble d'images). 

Afin de s'assurer que les indicateurs de champ de vision (FOV) sont corrects pour les axes verticaux et 

horizontaux sur la fenêtre d'affichage d'image pour les images d'étalonnage, les échelles de pixels X et Y 

correctes doivent être définies. Les échelles de pixels ont été correctement définies si les coordonnées WCS 

ont déjà été trouvées à l'aide de l'option calibration astrométrique (Plate Solve) de la fenêtre « CCD Data 

Processor » (voir Section 7.2.2.5) ou de l'une des options de résolution WCS- Section 7.4). Vous pouvez 

également saisir manuellement les échelles de pixels corrigés, en sélectionnant en haut de la fenêtre 

d'affichage des images, "WCS-> Set pixel scale for images without WCS ...", puis en saisissant les valeurs 

d'échelle X et Y à corriger. 

Le curseur situé sous l'image peut ensuite être utilisé pour parcourir toutes les images afin de trouver celles 

qui devraient être éliminées en raison d'une couverture nuageuse excessive, d'un mauvais guidage ou d'autres 

anomalies. Si les images montrent des degrés croissants de désalignement, reportez-vous à la Section 7.5.3 

pour savoir comment corriger cela. Les images pauvres peuvent être supprimées en affichant cette image 

particulière sur l'affichage d'image, puis en sélectionnant simplement l’icône supprimer la tranche 

actuellement affichée en haut à gauche de l'affichage de l'image. Alternativement, Edit-> Stack-> Delete peut 

être sélectionné dans la barre de menu de l'affichage de l'image. Il est toutefois conseillé de déplacer ces 

images pauvres du sous-répertoire de calibrage où elles résident dans un sous-répertoire séparé nommé 

"Images en quarantaine". Ainsi, si la photométrie différentielle doit être refaite sur les fichiers du sous-

répertoire de calibrage, l'utilisateur n'a plus besoin de recommencer ce processus d'élimination d'image. 

 

7.4. Calibration astrométrique « Plates Solves » à l'aide d'AIJ 
Des fonctions de calibration astrométrique associent des étoiles d’une image avec leurs coordonnées AD et 

DEC. Optionnellement, ces informations peuvent également être inscrites de manière permanente dans l'en-

tête FITS de l'image pour une utilisation ultérieure. Les informations inscrites dans l'en-tête FITS utilisent des 

informations WCS; cette information permet d'effectuer des essais ultérieurs pour identifier les coordonnées 

AD et DEC des étoiles sélectionnées. 

Voici des exemples où il pourrait être souhaitable des calibrations astrométriques une ou plusieurs images: 

1. il peut être utile de rogner une image pour localiser l'emplacement exact de l'étoile cible dans un champ 

bondé d'étoiles; 

2. Si les images sont mal alignées pendant la session d'observation ou si un flip méridien s'est produit, il peut 

être utile de suivre l'emplacement d'étoiles particulières d'une image à l'autre pendant la photométrie 

différentielle en utilisant leurs coordonnées RA et DEC. 

Les images qui contiennent des informations WCS provenant d'autres logiciels peuvent être utilisées par AIJ, 

ou AIJ lui-même peut être utilisé pour associer une ou plusieurs images dans la pile d'images. Ceci est fait en 

sélectionnant dans le menu d'affichage de l'image "WCS-> "Plate solve using Astrometry.net" (avec les 

options) ..." Une fenêtre similaire à celui de la figure 10 apparaît alors. 
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Figure 10. Fenêtre des paramètres d'astrométrie 

AIJ peut ensuite utiliser l'installation en ligne Astrometry.net pour la calibration astronomique, ou les 

utilisateurs de Windows peuvent utiliser une version locale qui ne nécessite pas de connexion en ligne. Ce qui 

suit décrit chacune de ces alternatives. 

 

7.4.1. Alternatives à Astrometry.net 
Alternative 1: calibration astronomique, à l'aide de la version en ligne d'Astrometry.net 

Pour cette alternative, une clé Astrometry.net doit être d'abord obtenue. Pour ce faire, connectez-vous sur 

http://nova.astrometry.net/signin/?next=/api_help en utilisant, par exemple, les informations de connexion 

Yahoo de l'utilisateur. La clé peut alors être trouvée sous mon profil. Il est appelé "ma clé d'API". Cette clé est 

ensuite entrée dans le champ clé utilisateur sur la fenêtre des paramètres d'astrométrie d'AIJ. 

Alternative 2: Résolution de plaques à l'aide d'une version locale d'Astrometry.net 

Les utilisateurs de Windows peuvent utiliser une alternative à la version en ligne d'astrometry.net pour 

effectuer la calibration astronomique. Dans ce cas, AIJ utilise un serveur local astrometry.net. Le serveur, 

développé par Andy Galasso et est appeler ansvr. Il peut être installé en allant sur 

http://adgsoftware.com/ansvr/ et en suivant les instructions d'installation. Une fois installé, la résolution des 

plaques peut être effectuée localement en activant « Utiliser le serveur personnalisé » sur la fenêtre des 

paramètres d'astrométrie (Astrometry settings) (voir la Figure 10). 

 

 

http://nova.astrometry.net/signin/?next=/api_help
http://adgsoftware.com/ansvr/
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7.4.2. Informations astrométriques 
Après avoir choisi l'alternative appropriée pour invoquer astrometry.net, les autres entrées suivantes doivent 

être effectuées sur la fenêtre « Astrometry settings »: 

1. « AutoSave » doit être coché si l'utilisateur souhaite que les en-têtes FITS des fichiers images d'origine 

soient mis à jour en permanence avec les informations WCS appropriées. 

2. Les numéros de tranche de l'image ou des images de la pile à calibrer astrométriquement doivent être 

saisis dans les champs Start Slice et End Slice. 

3. Les rayons des ouvertures et des anneaux qui seront utilisés pendant le processus de photométrie 

différentielle (voir la section 7.5.1 ci-dessous) doivent être entrés dans les champs Radius, Sky Inner et 

Sky Outer. 

4. La valeur d'échelle par pixel correcte pour le système d'imagerie de l'utilisateur doit ensuite être 

entrée, ainsi qu'une certaine tolérance pour sa précision. 

5. Ensuite, les coordonnées approximatives AD et DEC du centre de l'image, ainsi qu'un certain rayon de 

recherche pour les étoiles appropriées qui peuvent être utilisées pendant le processus de calibration 

astrométrique L'utilisateur peut essayer d'abord en commençant par la largeur de l'image, puis le réduire 

à partir de là. 

6. Toutes les autres valeurs et cases à cocher peuvent être définies telles qu'elles apparaissent dans la 

Figure 10. Lorsque START est sélectionné, le processus de calibration astrométrique commence. 

 

7.5. Effectuer la photométrie différentielle 
Avec des étoiles candidates connues, la photométrie différentielle peut avoir lieu sur les images de la pile. Voir 

la section 6.4.2 pour des directives sur la sélection des étoiles comparaisons appropriées. 

7.5.1. Sélectionnez les réglages d'ouverture et d'anneau appropriés 
La première étape consiste à définir le rayon approprié de l'ouverture et les rayons des bagues interne et 

externe de l'anneau. Cela se fait comme suit: 

L’icône           sur la fenêtre « Image Display » est sélectionné, ce qui provoque l'affichage de la fenêtre 

« Aperture Photometry Settings » (Figure 11). 
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Figure 11. Fenêtre des paramètres de photométrie d'ouverture (Aperture Photometry Settings) 

 

Les rayons initiaux de l'ouverture et de l'anneau (annulus) peuvent alors être réglés de manière 

appropriée en utilisant l'une des trois méthodes. 

Méthode 1. Les réglages initiaux des rayons peuvent être déterminés à l'aide de la fenêtre « Seeing 

Profil » associé à l'étoile cible (voir Figure 12). Cette fenêtre apparaît lorsque l'étoile cible est sélectionner 

avec le bouton droit de souris tout en maintenant le bouton « ALT » du clavier. Le rayon indiqué pour la 

source et les valeurs de début et de fin pour l'arrière-plan peuvent être utilisés respectivement pour le 

rayon d'ouverture initial et les rayons de l'espace intérieur et extérieur. 
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Figure 12. Affichage de la fenêtre « Seeing Profil » 

Méthode 2. Les rayons initiaux peuvent aussi être déterminés selon les directives suivantes (notez que la 

sélection automatique par AIJ des valeurs recommandées par la méthode 1 est conforme à ces directives): 

1. Le rayon initial de l'ouverture (r1) doit être au moins 2 fois le nombre de pixels FWHM. 

2. Le rayon initial de l'anneau intérieur (r2) doit être choisi de manière à ce que le rayon de l'anneau externe 

crée une zone annulaire excluant toute autre étoile proche de l'étoile cible. 

3. La valeur initiale du rayon de l'anneau extérieur doit être égale à SQRT (4 * r1
2 + r2

2).  Cette formule devrait 

produire un anneau qui contient 4 fois le nombre de pixels qui se trouvent dans l'ouverture. 

(* SQRT = racine carré). 



Guide pratique de l'observation des exoplanètes | Révision 3.1 Septembre 2017__________________________                                                        

33 
 

Méthode 3. Finalement, les réglages initiaux d'ouverture / d'anneau peuvent être déterminés en utilisant ceux 

qui maximisent le rapport signal sur bruit de l'étoile cible. AIJ peut être utilisé pour déterminer le SNR de 

l'étoile cible de la manière suivante: 

 
1. Cliquez sur l’icône « Change aperture setting » sur la fenêtre d'affichage des images. 
Réglez l'ouverture et les rayons annulaires sur certains paramètres initiaux, puis cliquez sur OK. 
 

2. Cliquez sur l'icône   « Single Aperture Photometry » dans la barre d'outils de AIJ. Placez les 
cercles concentriques résultants sur l'étoile cible dans l'affichage d'image et faites un clic gauche. 
 
3. Cela produira une nouvelle table de mesures qui devrait inclure la mesure SNR sous la colonne 
« Source SNR ». Chaque modification ultérieure des paramètres d'ouverture et des sélections de 
photométrie à ouverture unique ajoutera une nouvelle ligne à cette table. 

 
Remarque: chaque nouvelle ligne (étrangère) nouvellement créée dans la table de mesures doit ensuite être 

supprimée avant que la table de mesures ne soit utilisée pour la modélisation du transit. Pour ce faire, mettez 

en surbrillance la ou les lignes à supprimer dans le tableau mesures, puis sélectionnez Edit-> Cut dans la barre 

de menus de la table mesures. 

Parmi les trois procédés ci-dessus, le procédé 1 est le préféré pour obtenir un ensemble initial de réglages 

d'ouverture et d'espace annulaire. 

Il convient de noter que les réglages définitifs de l'ouverture et des rayons annulaires doivent être ceux qui 

minimisent le carré moyen des résidus de la courbe de lumière créée pendant l'ajustement du modèle de 

transit. RMS est une mesure de la façon dont le modèle "s'adapte" aux données observées. Cela implique que 

plusieurs exécutions de l'ajustement du modèle, comme décrit dans la section 7.11 ci-dessous, doivent être 

exécutées avec des valeurs différentes pour les réglages d'ouverture et de rayons annulaires. 

 

 

7.5.2. Préparer et commencer la photométrie différentielle 
En parcourant les images de la pile, il peut sembler qu'elles sont progressivement décalées les unes par 

rapport aux autres et qu'elles ne sont donc pas toutes alignées. Les sections 7.5.3 et 7.5.4 ci-dessous montrent 

comment gérer différents degrés de désalignement, ainsi qu'un flip méridien. 

Sur la fenêtre des paramètres de photométrie d'Aperture (Figure 11), l'utilisateur doit entrer une liste de 

mots-clés séparés par des virgules pour les valeurs d'en-tête FITS que l'utilisateur souhaite extraire et ajouter à 

la table de mesures. De plus, les valeurs appropriées pour le gain du CCD, le bruit de lecture et le courant 

d'obscurité doivent être entrées. Enfin, les paramètres appropriés pour les avertissements de saturation et de 

linéarité doivent être définis. Toutes les autres cases à cocher pourraient être conservées comme indiqué sur 

la figure 11. L'utilisateur sélectionnerait ensuite OK. 

Ensuite, l'icône de la barre de menus de l'affichage de l'image sera sélectionnée pour faire apparaître la 

fenêtre « Multi-Aperture Measurements » (voir Figure 13). Les valeurs pour la gamme de tranches et les 

rayons d'ouverture et d'annulus sont automatiquement remplies.  

Si toutes les images ont été résolues, il est possible de vérifier « Use RA/Dec to locate aperture positions » 
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(Utiliser AD / DEC pour localiser les positions d’ouverture). Toutes les autres cases à cocher pourraient être 

conservées comme dans la figure 13. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 13. Fenêtre de mesures à ouverture multiple 

L'utilisateur doit également avoir activé les quatre icônes suivantes dans la barre de menus de l'affichage 

de l'image: 

 

 

Ces sélections permettent d'afficher les anneaux d'ouverture / annulaire avec les noms d'étoiles cible et 

comparaisons et les comptages d'intensité associés, et de positionner automatiquement les anneaux 

d'ouverture / annulus sur le centroïde de chaque étoile. 

L'utilisateur sélectionne alors placer les ouvertures, puis place et clique sur les cercles concentriques flottants 

sur l'étoile cible et les étoiles comparaisons. L'affichage de l'image apparaîtrait alors similaire à celui de la 

figure 14. 
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Figure 14. Exemple d'image avec ouverture / anneau appliquée à la cible et aux étoiles de 

comparaisons. 

Ensuite, en appuyant sur Entrée sur le clavier, le processus de photométrie différentielle va commencer. Une 

table de mesures sera construite avec chaque ligne représentant les mesures pour chaque tranche dans la pile. 

Les étiquettes dans l'en-tête de la table de mesures identifient le type de données dans la colonne de 

l'étiquette. Certaines de ces étiquettes correspondent à des identificateurs d'en-tête FITS courants et d'autres 

sont les mots-clés spécifiés dans la fenêtre Paramètres de photométrie d'ouverture (voir la figure 11). 

À ce stade, la table « Measurements » doit être enregistrée dans un sous-répertoire Préalablement appelé par 

exemple « AIJ Analysis ». Pour se faire, sélectionnez File -> Save as » sous dans le menu Tableau des mesures 

et sélectionnez le sous-répertoire Analyse AIJ. La table de mesures est stockée par AIJ avec une extension de 

.xls et est un fichier délimité par des tabulations. 

Il convient de noter que si la photométrie différentielle doit être refaite sur les images actuellement dans 

la pile, les étapes suivantes doivent être effectuées: 
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1. Effacez les anneaux d'ouverture / annulaire existants en sélectionnant l'icône          « Clear apertures and 

annotations from overlay» sur l'affichage de l'image. 

2. Sur la fenêtre « Multi-Aperture Measurements » (Figure 13), assurez-vous que la case à cocher à côté de 

« Use previous X apertures » n'est pas cochée. 

 

 

7.5.3. Traitement des images mal alignées 

     

Un changement d'orientation de l'image et donc un désalignement pourrait être le cas si le guidage est 

médiocre. Si le décalage d'image n'est pas trop important, la fonction « Align Stack » d'AIJ peut être utilisée 

pour aligner les images dans la pile active. Ceci peut être réalisé en sélectionnant l'icône            « Aling stack 

using apertures" sur la fenêtre d'affichage des images et en entrant un réglage d'ouverture assez grande avec 

des réglages d'annulus plus grands. Les images de la pile sont alignées à l'aide de cette fonctionnalité et les 

images alignées résultantes sont sauvegardées dans un nouveau sous-répertoire intitulé « aligned ». Les 

images de ce sous-répertoire doivent alors être utilisées pendant la phase de photométrie différentielle. 

L'utilisateur ne doit pas oublier de changer les réglages de l'ouverture et de l'anneau en fonction de la phase 

de photométrie différentielle. 

Dans le cas d'une rotation d'image due à un décalage d'image important, la fonction « Align » d'AIJ ne peut pas 

corriger, alors ce qui suit peut-être fait: 

1. Tout d'abord, effectuer une calibration astrométrique sur chaque image (voir la section 7.4). 

2. Une fois la calibration astrométrique terminée, l'utilisateur peut effectuer la photométrie 

différentielle comme précédemment, sauf que sur la fenêtre « Multi-Aperture Measurements » (Figure 

13), il convient de cocher la case « Use RA/Dec to locate aperture positions ». De plus, la première et la 

dernière tranche devraient indiquer toute la gamme de tranches. 

3. Lorsque le bouton « Place apertures » est sélectionné sur cette fenêtre, l'utilisateur place les anneaux 

d'ouverture / d'annulaire sur la cible et étoiles de comparaisons et, comme précédemment, appuyez sur 

Entrée sur le clavier. Toutes les images de la pile sont maintenant analysées. 

 

7.5.4. Faire face à un « Retournement au méridien (Meridian Flip) » 
Si un retournement méridien avait eu lieu pendant la séance d'imagerie, les images seraient tournées de 180 ° 

par rapport à l'orientation représentée sur la figure 5. Ainsi, pour les images prises après le retournement, les 

anneaux d'ouverture / d'anneau ne tomberaient pas aux endroits corrects pour la cible et les étoiles 

comparaisons. Remarque: même si la caméra CCD a été tournée immédiatement avant le début de l'imagerie 

après le retournement méridien, il est peu probable que les étoiles cible et de comparaisons atterrissent dans 

les mêmes anneaux d'ouverture / d'anneau. 

Pour effectuer une photométrie différentielle avec AIJ dans le cas d'un flip méridien, la méthode suivante peut 

être utilisée (note: s'il y a des images mal alignées pendant la période de pré-flip ou pendant la période post-

flip, la méthode décrite dans la section 7.5. 3 devrait être utilisé): 
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1. Tout d'abord, la calibration astrométrique résous juste la première image de la séquence entière. Pour ce 

faire, saisissez "1" dans les champs « Start Slice » et « End Slice » de la fenêtre « Astrometry Settings ». Cela 

fera juste que la première image de la pile soit calibrée astrométriquement. 

2. Ensuite, le numéro de tranche pour l'image dans la pile qui suit immédiatement le flip méridien devrait être 

entré dans ces deux champs et il devrait être résolu calibrée astrométriquement. 

3. La fenêtre « Multi-Aperture Measurements » (voir la Figure 13) doit alors cocher la case « Use RA/Dec to 

locate aperture position » et cocher la case « Halt processing » on « WCS ou centroid error ». 

Lorsque la photométrie différentielle est maintenant effectuée, AIJ procèdera à travers les images pré-flip, en 

utilisant les coordonnées de la première tranche pour placer l'ouverture et l'anneau sur les images pré-flip 

suivantes, puis en utilisant les coordonnées de la première tranche après la retourner pour les images 

restantes dans la pile. 

 

7.6. Se préparer à l'ajustement du modèle 
En préparation d'un ajustement du modèle, l'icône             « Multi-Plot Main » de la barre d'outils AIJ doit être 

sélectionnée. Lorsque cela est fait, les quatre fenêtres suivantes apparaissent: 

Multi-plot Main  

Multi-plot Reference  

Star Settings Multi-plot Y-data  

Data Set 2 Fits Settings. 

Un fichier AIJ avec une extension *.plotcfg contient les informations utilisées pour créer ces fenêtres. Un 

fichier template.plotcfg que l'utilisateur peut commencer peut être trouvé à http://astrodennis.com . 

L'utilisateur peut ouvrir un fichier *.plotcfg en allant dans le coin supérieur gauche de la fenêtre « Multi plot 

main » et en sélectionnant "File-> Open plot configuration from file..." De même, l'instance actuelle des 

fenêtres ci-dessus peut être sauvegardé en sélectionnant " File-> Save plot configuration…" 

La première étape consiste à mettre à jour les valeurs corrigées dans les entrées de colonne AIRMASS, 

HJD_UTC et BJD_TDB dans la table de mesures si cela n'a pas été fait pendant la phase d'étalonnage (voir la 

section 7.2 ci-dessus). Ceci est accompli comme suit: 

Dans le menu de « Multi plot main », sélectionnez " Table->Add new astronomical data columns to table". 

Les deux fenêtres suivants apparaissent alors: "MP Coordinate Converter" et " Add astronomical data to 

table" (Voir figure 15). 

 

http://astrodennis.com/
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Figure 15. Fenêtre pour corriger les valeurs AIRMASS et Time Standard 

 

Sur la fenêtre « MP Coordinate Converter », vérifiez que les valeurs sont correctes pour l'emplacement 

géographique de l'observatoire et les coordonnées équatoriales J2000 pour l'étoile-cible. Sélectionnez 

également Mettre à jour et Auto sous la section « Dynamic Time ». Sur la fenêtre "Add astronomical data to 

table", vérifiez que les cases sont cochées comme indiqué dans la fenêtre le plus à droite de la figure 15, puis 

sélectionnez Mettre à jour la table. Appuyez sur OK si la boîte de dialogue " Over-write existing data?” 

Apparaît. Les colonnes AIRMASS, HJD_UTC et BJD_TDB dans la table « Measurements » sont ensuite mises à 

jour. 

 

 

 

7.7. Faire l'ajustement du modèle 
 

Sur la fenêtre « Multi-Plot Main », remplissez les entrées « Title » (Titre) et « Subtitle » (Sous-titre), (voir la 

Figure 16). Sous la zone Sélection et sélection de la région de normalisation, des entrées sont faites pour les 

cases de gauche et de droite qui représentent respectivement les temps de début et de fin de transit prévus. 

En haut à droite de la fenêtre « Multi-Plot Main », l'icône de copie            est alors sélectionnée. Ceci 

positionne les temps d'entrée prédite et d'évacuation prévue sur les marqueurs V. aux endroits appropriés sur 

« Plot of Measurements ».  
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Les « V.Marker » ne devraient pas être modifiés par la suite afin de montrer les prédictions initiales. 

Cependant, les marqueurs d'ajustement et de normalisation devraient être positionnés plus tard aux points 

d'entrée et de sortie apparents, comme indiqué sur la fenêtre « Plot of Measurements » (Figure 22). En outre, 

les champs « Trim Left » et « Trim Right » peuvent être utilisés pour éliminer une certaine quantité de 

données pré-entrée et post-sortie du modèle. Cela pourrait être fait, par exemple, s'il y avait des données 

systématiques au début ou à la fin de la session d'observation. Les valeurs dans les zones Meridian Flip, Fit et 

« Normalize Region » et « V.Marker » ne sont que la partie décimale du temps associé (par exemple, 0.83508 

serait entré si l'heure en question était 2457395.83508). Si, par contre, l'heure de début est, par exemple, 

2457395.83508 et que l'heure de fin "passe" en, disons, 2457396.00175, la partie décimale de début devrait 

être 0.83508, mais la partie décimale finale devrait être 1.00175. 

Ensuite, sous la zone « Scaling » de l'axe des X, cochez le bouton Auto X-range et cliquez sur l'icône. Les cases 

X-min et X-max seront automatiquement renseignées avec les valeurs X minimales et maximales (BJD_TDB fois 

dans cet exemple) qui se trouvent dans la table « Measurements ». Remarque: pour que cela fonctionne, au 

moins une ligne de la fenêtre « Multi-plot Y-data » (voir Figure 17) doit être cochée dans la colonne Plot. 

L'utilisateur peut également cliquer sur la zone X-range personnalisée et remplir les différentes valeurs X-min 

et X-max.  La boîte de mise à l'échelle de l'axe Y peut être utilisée maintenant ou plus tard pour permettre aux 

différentes parcelles d'être dimensionnées afin qu'elles apparaissent toutes sur la fenêtre « Plot of 

Measurements » (voir la Figure 22). Les entrées de taille de tracé sont utilisées pour dimensionner la fenêtre 

« Plot of Measurements » sur le moniteur de l'ordinateur de l'utilisateur. 
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Figure 16. Fenêtre « Multi-plot Main Screen » 

 

Si un retournement de méridien a eu lieu ou s'il y a une interruption de la session d'image et que les étoiles se 

sont déplacées vers une autre partie du détecteur CCD, la case « Meridian Flip » de la fenêtre « Multi-plot 

Main » est utilisée pour placer une ligne le milieu de l'écart où cette discontinuité des données s'est produite. 

La case « Show » doit être cochée et une entrée doit être placée dans la case Retourner l'heure de manière à 

ce que la ligne Meridian Flip soit placée sur la fenêtre « Plot of Measurements » à l'endroit approprié. 
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7.8. Courbe de courbe légère 
Avant qu'un graphique visuel des ensembles de données sélectionnés puisse être obtenu via la fenêtre « Plot 

of Measurements » (Figure 22), la fenêtre de « Multi-plot Y-data » (Figure 17) doit être configuré. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17. Fenêtre de données « Multi-plot Y Data Screen » 

Voici les principaux paramètres et sélections de la fenêtre « Multi-plot Y-data »: 

La colonne Plot permet de sélectionner si un ensemble de données particulières doit être tracé dans le 

graphique. 

La colonne Y-data est utilisée pour sélectionner les ensembles de données (à savoir les colonnes de la table de 

Mesures) qui sont associés à une rangée dans le graphique. 

La colonne Bin Size indique le nombre de points dans le jeu de données associé qui sont combinés (binned) en 

un seul point. Typiquement, seul le flux relatif associé aux étoiles comparaisons (c'est-à-dire, rel_flux_Ci) est 

regroupé. Notez que le regroupement est uniquement à des fins d'affichage et ne modifie pas les données de 

table de mesures sous-jacentes. 

La colonne « Fit Mode » est utilisée pour sélectionner le type d'ajustement qui doit être appliqué à l'ensemble 

de données respectif, ainsi que la plage de données (indiquée par la zone verte) qui sera incluse dans 
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l'ajustement. Ainsi, comme on peut le voir sur la figure 22, les points de données brutes du changement relatif 

de flux de T1 sont tracés sans ajustement, alors que le second graphique est un ajustement de ces mêmes 

données en utilisant un modèle de transit supposé. Enfin, les changements de flux relatifs de trois étoiles de 

comparaisons sont ajustés avec un modèle linéaire (comme on le verra plus loin, une des étoiles comparaisons 

originales, C5, a été désélectionnée après avoir trouvé des erreurs résiduelles significatives). La raison pour 

laquelle les trois derniers graphiques sont linéaires est que l'on suppose qu'il ne devrait y avoir aucun 

changement relatif de la luminosité de l'étoile comparaison pendant toute la session d'imagerie contrairement 

au flux relatif de T1 où il est supposé d’obtenir une baisse de la luminosité due au transit de l'exoplanète. 

La colonne Trend Select sert deux objectifs. Tout d'abord, il reflète les paramètres de "Detrend" qui sont 

appliqués au modèle d’ajustement de la courbe associée (colonne Fit Mode), eux-mêmes sélectionnés dans la 

fenêtre « Data Set 2 Fit Settings » (Figure 18). Les paramètres « Detrend » actifs sont indiqués en vert. 

Deuxièmement, la sélection d'un paramètre « Detrend » particulier reflète son coefficient de tendance et le 

type associé de données de « Detrend » (par exemple, AIRMASS). 

*( « Detrend » est un facteur de correction qui s’applique sur la courbe choisie) 

La colonne Norm / Mag Ref indique la plage de données utilisée pour normaliser l'ensemble de données 

respectif. Dans l'exemple de la figure 17, le flux relatif de T1 est normalisé à partir des données hors transit - 

c'est-à-dire à gauche du début de transit (point d'entrée) et à droite de la fin de -transit (point de sortie). Ces 

deux derniers points sont définis par les valeurs « Fit » et « Normalized Region » de la fenêtre « Multi-plot 

Main » (Figure 16). 

Lorsque cette case est cochée, la colonne Page Rel indique que les colonnes Scale et Shift doivent être 

interprétées comme le pourcentage de la plage Y. Décochée signifie que les valeurs d'échelle et de décalage 

sont des nombres absolus appliqués à la plage Y. Les valeurs d'échelle et de décalage, ainsi que les valeurs Y-

min et Y-max de la fenêtre « Multi-plot Main », permettent de positionner correctement les différents tracés 

sur le graphique. Il convient de noter que l'ensemble de données brutes représentant le flux relatif de T1 (à 

savoir la première ligne de la figure 17) doit toujours avoir une valeur d'échelle = 1. Ceci est dû au fait que ces 

données peuvent être utilisées globalement par d'autres programmes d’ajustement graphique et ne devraient 

pas être mis à l’échelle. 

 

7.9. Fenêtre des jeux de paramètres de données 
 

La fenêtre « Data Set 2 Fittings» (Figure 18) est automatiquement ouverte chaque fois qu'un ajustement 

graphique de transit est sélectionné pour un ensemble de données (dans ce cas, « Data Set 2 ») de la colonne 

« Fit Mode » de la fenêtre « Multi-plot Y Data » (Figure 17). Les entrées utilisateurs suivantes sur la fenêtre 

« Data Set 2 Fittings Set » sont effectuées et affectent la courbe de lumière résultante: 

Période - entrez la période orbitale, si elle est disponible, à l'adresse http://exoplanets.org/; par exemple, dans 

le cas de WASP-12b, il est de 1,09142245 jours. 

Paramètres de l’étoile hôte (Host Star Parameters) - entrez le type spectral (Sp.T) de l'étoile hôte; c'est 

strictement pour estimer le rayon R* de l'étoile hôte, qui sert elle-même à calculer le rayon de l'exoplanète. Si 

l'utilisateur connaît la valeur du R* (par exemple, à partir de http://exoplanets.org/), cette valeur peut être 

entrée dans la boîte R*(RSun). Dans cet exemple pour WASP-12, R* = 1.630. 

http://exoplanets.org/
http://exoplanets.org/
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Quad LD U1 et Quad LD U2 - Ce sont les « coefficients d'assombrissement quadratique centre-bord *» 

(quadratic limb darkening coefficients) associés à l'étoile hôte et au filtre particulier utilisé. Ces valeurs 

peuvent être trouvées à l'aide de la calculatrice de coefficient d’assombrissement centre-bord sur : 

http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml.   

 

Dans l'exemple ici, les coefficients utilisés pour WASP-12b sont respectivement de 0,39056081 et 0,3026992. 

Notez que ceux-ci sont placés dans la colonne « Prior Center » et verrouillés. 

(*https://fr.wikipedia.org/wiki/Assombrissement_centre-bord) 

La valeur « AIRMASS Prior Center » doit être définie sur 0,0 dans la plupart des cas. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18. Fenêtre de paramétrage de « Data Set 2 fits setting » 

Les valeurs Y-min et Y-max de la fenêtre « Multi-plot Main » peuvent être ajustées pour afficher les parties 

souhaitées du tableau de mesures sur le graphique, bien que, comme mentionné précédemment, il est 

préférable de sélectionner Auto-X-range sous X-Axis Scaling de la fenêtre « Multi-plot Main » pour afficher 

toute la plage des valeurs X. 

http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml
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Il est possible de voir comment le modèle de la courbe du graphique est amélioré en appliquant un nombre 

quelconque de paramètres de correction. Le plus commun est AIRMASS. D'autres paramètres de correction 

peuvent également être sélectionnés. Si un flip méridien ou une pause dans la collecte de données s'est 

produit où les étoiles ont bougé sur le détecteur CCD, alors « Meridian_Flip » peut également être sélectionné 

(notez que si cela est fait, une valeur doit être inscrite dans la case « Flip Time » de la fenêtre « Multi-plot 

Main » (figure 16)).  D'autres paramètres de correction peuvent également être sélectionnés pour voir leurs 

effets sur l'ajustement de la courbe du modèle. Une bonne règle de base pour savoir si un paramètre 

« Detrend » est efficace est de voir la valeur BIC (Bayesian Information Criterion). S'il diminue de plus de 2.0 

lorsqu'un paramètre « Detrend » est sélectionné, donc ce paramètre « Detrend » doit être sélectionné. Au 

contraire s'il diminue de moins de 2.0 ou augmente, alors le paramètre « Detrend » n'est pas pertinent. 

« Plot Settings » de la fenêtre « Data Set 2 Fit Setting » permettent de définir si et comment le modèle de 

transit et les erreurs résiduelles sont affichés. De plus, une valeur Shift est utilisée pour déplacer la courbe des 

erreurs résiduelles vers le haut ou vers le bas sur la fenêtre « Plot of Measurements ». 

Enfin, la fenêtre de l'étoile de référence « Multi-plot Reference Star Settings » (Figure 19) permet de 

désélectionner ou de sélectionner les étoiles que l'utilisateur aimerait inclure dans l'ajustement du modèle. 

Ceci est utile s'il est déterminé après avoir observé le flux relatif d'une étoile de comparaison particulière dans 

la fenêtre « Plot of Measurements ». (Figure 22) que ses points de données ne suivent pas un ajustement 

linéaire, c'est-à-dire une étoile variable. Dans l'exemple ici, il a été déterminé que l’étoile de comparaison C5 

avait un grand nombre d'erreurs résiduelles. Ainsi, il a été désélectionné de l'ensemble des étoiles 

comparaisons à utiliser (voir figure 20). Lorsque cette désélection a eu lieu, l'identificateur de l'étoile 

comparaisons C5 a été changé en T5 sur la fenêtre représentée sur la Figure 20, ainsi que sur l'affichage de 

l'image (voir Figure 21). Sa boîte de sélection des parcelles de la figure 17 n'a pas été cochée, de sorte que son 

tracé n'apparaît plus sur la figure 22. 

 

 

 

 

 

 

 

 

 

Figure 19. Fenêtre des paramètres de « Multi-Plot Reference Star Settings » 
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Figure 20. Fenêtre Paramètres de « Multi-Plot Reference Star Settings » après que C5 a été désélectionné 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 21. Affichage des images mises à jour montrant C5 modifié en T5 

 

Notez que les données de C5 ne sont désormais pas incluses dans l'ajustement du modèle, mais ses données 

sont toujours conservées dans la table de mesures. 

Les réglages de la Figure 16, de la Figure 17, de la Figure 18 et de la Figure 20 ont produit la courbe de lumière 

et d'autres tracés montrés sur la Figure 22. 
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La figure 23 est un exemple d'ajustement d'une exoplanète basé sur les données recueillies par l'astronome 

amateur Paul Benni pour l'exoplanète Wasp-76b. Il montre comment un paramètre « Meridian_Flip detrend » 

a été utilisé pour prendre en compte un décalage dans les points de données provoquées par les étoiles cibles 

et de comparaisons atterrissant sur une autre partie du détecteur CCD après le retournement méridien. 

 

Figure 22. Fenêtre “Plot of Measurements” 
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Figure 23. Exemple d'utilisation du paramètre Meridian Flip Detrend 

 

7.10. Enregistrement des données de modèle de courbes 
Comme tout le graphique précédent ne correspond pas à la table des mesures, il est conseillé à l'utilisateur de 

sauvegarder l'état actuel de ces paramètres et d'autres paramètres en sélectionnant « File -> Save all » ou 

« File -> Save as » (avec options) en haut à gauche de la fenêtre « Multi-plot Main». 
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7.11. Optimisation de l'ajustement du modèle de courbes 
Avec les différentes entrées que l'observateur de l'exoplanète peut modifier et qui pourraient affecter 

l'ajustement du graphique à un ensemble donné de données, plusieurs questions se posent: 

1. Quelles variables d'entrée devraient être changées? 

2. Dans quel ordre devraient-ils être changés? 

3. Quand le meilleur ajustement du graphique est-il atteint? 

Afin de répondre à ces questions, les lignes directrices suivantes sont fournies. Ceux-ci sont destinés à 

optimiser uniquement les transits complets, et non les transits partiels, après un ajustement initial du modèle: 

1. Initialement, sélectionnez AIRMASS comme seul paramètre de « detrend ». Si un retournement au méridien 

a été fait, alors « Meridian_Flip » doit être maintenu comme paramètre de « detrend » tout au long des 

étapes restantes ci-dessous. 

2. Déterminer les effets sur RMS de différentes étoiles de comparaison supprimées (comme vu 

précédemment, AIJ permet à l'utilisateur de "désélectionner" facilement une étoile de comparaison, auquel 

cas tous les calculs associés à cette étoile sont refaits). Si le RMS diminue lorsqu'une étoile de comparaison 

particulière est désélectionnée, ne la sélectionnez pas. Il arrive parfois que le flux relatif de ces étoiles montre 

également une quantité de dispersion supérieure à l'étoile cible et aux autres étoiles de comparaison. 

3. Avec la sélection ci-dessus des étoiles de comparaison et AIRMASS restant le seul paramètre « detrend » 

(avec peut-être l'ajout du « Meridian Flip »), refaire la photométrie différentielle et le modèle de courbe 

s'ajuste avec des rayons d'ouverture et d'annulus de plus en plus petits. Déterminer les effets sur RMS pour 

chaque nouvelle combinaison de rayons. Choisissez la combinaison qui donne le RMS le plus bas. 

4. Répétez l'étape 2 sur ce nouvel ensemble de rayons pour obtenir le meilleur RMS. En plus de la valeur RMS 

résultante, enregistrer la valeur BIC qui va avec le meilleur RMS. 

5. Déterminer les effets de différents paramètres de détriment. Tout d'abord, retirez AIRMASS et vérifiez si BIC 

augmente de 2 ou plus. Si c'est le cas, conservez AIRMASS pour le détriment; Si ce n'est pas le cas, n'incluez 

pas AIRMASS. Ensuite, ajoutez les paramètres de détriment suivants un par un et observez les changements 

dans la valeur BIC: 

a. Width_T1, 

b. Sky / Pixel_T1, 

c. X (FITS) _T1, 

d. Y (FITS) _T1, 

e. tot_C_cnts, 

f. temps (par exemple, BJD_TDB), 

g. CCD-TEMP. 

Parmi les paramètres de réduction qui entraînent au moins une réduction de deux (2) dans la valeur BIC, 

choisissez les 3-4 paramètres qui entraînent la plus grande réduction de cette valeur. 

6. En utilisant l'ensemble de paramètres de détritus résultant, répétez l'étape 2 pour voir les effets sur RMS de 

retirer une ou plusieurs étoiles de comparaison.  Il convient de noter que la réalisation de toutes les étapes 

ci-dessus est facultative. Cependant, si les résultats de l'ajustement du modèle sont fournis à une équipe 
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scientifique et que ces étapes ne sont pas effectuées par l'observateur, les images calibrées originales de 

l'observateur devront peut-être être transférées à l'équipe scientifique pour qu'elles effectuent. 

 

7.12. Entrée aux programmes externes 
 

Pour certaines campagnes de recherche d'exoplanètes, l'observateur de l'exoplanète peut être invité à 

soumettre certaines données pour utilisation par des programmes externes. L'exemple ci-dessous montre 

comment un fichier peut être créé pour un programme d'ajustement global qui nécessite ce qui suit pour 

chaque point de données: son temps BJD_TDB, le flux relatif normalisé de l'étoile cible pour ce point de 

données, l'erreur du flux relatif normalisé du l'étoile cible et les valeurs de tous les paramètres de 

détérioration utilisés dans l'ajustement du modèle AIJ. 

La création d'un tel fichier s'effectue comme suit: 

Cliquez sur la flèche vers le bas de New Col pour l'ensemble de données représentant le flux relatif normalisé 

de l'étoile cible (dans l'exemple utilisé ici, il s'agirait de la première flèche vers le bas de New Col dans la Figure 

17). Une fenêtre pop apparaît alors et les entrées seront effectuées comme indiqué sur la figure 24. 

 

 

 

 

 

 

 

 

 

Figure 24. Fenêtre pour ajouter de nouvelles colonnes à la table de mesures. 

 

Lorsque le OK est sélectionné, trois nouvelles colonnes sont ajoutées à la table de mesures. Ces colonnes 

ajoutent pour chaque image le flux relatif normalisé de l'étoile cible et l'erreur du flux relatif normalisé de 

l'étoile cible, en plus du temps BJD_TDB. 

Enfin, pour générer un fichier contenant ces informations pour un programme externe global, la sélection 

« File-> Save data subset to file... » se fait à partir de la fenêtre « Multi-plot Main ».  

La fenêtre « Save Data Subset » apparaît alors (Figure 25) et les entrées sont effectuées comme indiqué. 

Dans ce cas, la valeur BJD_TDB, le flux relatif normalisé de l'étoile cible, l'erreur du flux relatif normalisé 

de l'étoile cible et les valeurs AIRMASS sont sélectionnées. L’AIRMASS est inclus, car le paramètre « detrend » 

a été utilisé dans l'ajustement du modèle graphique AIJ. 
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Figure 25. Fenêtre « Save Data Subset » 

Lorsque le bouton OK est sélectionné, un fichier séparé contenant ces valeurs est créé. Remarque: les valeurs 

dans les colonnes du Bin Size et du Scale dans la fenêtre « Multi-plot Y » (voir Figure 17) affectent le calcul du 

flux relatif pour T1 dans cet exemple. Si l'une de ces valeurs a été modifiée, réinitialisez-les à Bin Size = 1 et à 

Scale = 1 avant de cliquer sur la flèche vers le bas de la nouvelle colonne dans l'exemple ci-dessus, sauf si ces 

modifications sont intentionnelles (par exemple, si l'on souhaite stocker des points de données). 

 

8. Résumé 
 

Tel qu'indiqué dans l'introduction, ce guide était conçu comme une approche pratique, étape par étape, de 

l'étalonnage de l'image, de la photométrie différentielle, de la courbe de lumière et de la modélisation 

graphique du transit de l'exoplanète au moyen de l'AIJ. Les utilisateurs sont invités à contacter l'auteur à 

l'adresse e-mail suivante pour toute modification suggérée dans les zones qui ne sont pas claires et pourraient 

utiliser des explications supplémentaires: dennis@astrodennis.com. 

 

 

 

 

 

 

 

mailto:dennis@astrodennis.com
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Appendix A:  

Observation Worksheet 

  


